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A Note to Instructors — 

Thank you for putting your trust in BIOPAC Products and welcome to the global community of 

Biopac Student Lab Instructors and Researchers. The Biopac Student Lab System was designed 

with ease of use as its main goal. We have made every effort to design a system that allows the 

student to concentrate on the study of physiology instead of the interconnections of the hardware 

or complicated transducer calibration. We have also designed the system to be “student proof” to 

prevent new users from tampering with the recording parameters or calibration procedures.  

This purpose of this Instructor’s Guide is to detail the setup and customization features of the 

Biopac Student Lab program for instructors and lab assistants, and to offer supplemental material 

with a focus on configuring the BSL Lesson content and preferences to best suit your curriculum. 

This guide assumes you have some basic familiarity with using the BSL program. For a complete 

overview of the Biopac Student Lab software, please see the Biopac Student Lab Tutorial under 

the Help Menu or watch the BSL Tutorial video here. 

Please keep these important points in mind when working with the Biopac Student Lab: 

1. The BSL Lessons software automatically saves the data files under a file name created by the 

student at the start of each lesson.  

2. The software expects to see the files and folders within the “Biopac Student Lab” folder. 

Never rename these files and folders, or move any files or folders out of the Biopac Student 

Lab folder. 

• The lone exception is that the student’s data and journal files contained in the “Data 

Files” folder can be copied, moved and/or deleted. The entire folder should be moved 

rather than individual files. 

It is also a good practice to keep unrelated files or folders out of the “Biopac Student Lab” 

folder. 

3. If students gather a basic understanding of the Biopac Student Lab software before starting 

the first lab, they’ll have a much better chance of recording good data and having a positive 

experience. We recommend that Students download our free Analysis only software (Mac or 

Windows) which also provides lesson preparation material. At the very least, Students should 

review the BSL Tutorial video here. If this is not an option, then Students should review the 

Biopac Student Lab Tutorial (under the Help menu) to obtain a basic understanding of how 

the Biopac Student Lab works. 

4. Each student’s recording is automatically saved at the end of each lesson. Students do not 

need to resave the file unless they make a change to the Journal or the data window settings 

while in the Review Saved Data (Analysis) mode. 

• It is recommended that students use the “Save Changes” option under the File menu 

rather than the “Save As” option. This will ensure that the student’s files are saved to the 

location specified for the lab (computer hard drive, school network, etc). Saving in this 

way to a consistent location will help manage the files/folders and prevent student errors. 

• If students wish to take a file home for analysis, simply copy the file to a flash drive or 

other media, or email the file. The files can also be shared to any Dropbox account by 

choosing the Dropbox options in the File menu. (BSL 4.1 and higher) 

5. If time permits, students are advised to read the “Beyond Basics” section and follow along 

on the computer with the Sample Data file. 

Typically, labs work most efficiently with three or more students working per station. Usually a 

more experienced student runs and calibrates the equipment, another student acts as the Subject for 

transducer attachment, another takes notes, and there are often one or more students that act as 

observers.  

http://www.biopac.com/Videos.ASP?Cat=Student
http://www.biopac.com/Updates.asp
http://www.biopac.com/Videos.ASP?Cat=Student
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The BSL System is designed to allow at least four students to record and save data in a normal lab 

period (60-90 minutes). The Lessons are broken down into four main sections: Introduction, 

Recording, Analysis, and Data Report. The Recording section includes the Set Up and 

Calibration procedures. The Lesson Procedure PDFs and onscreen Lesson Journal instructions will 

guide students through the recording steps in order to ensure that high quality data is collected and 

saved. 

The Analysis section can be looked at as a separate step. If time permits in the normal lab period, the 

students can go right from recording to analysis. However, to relieve perceived time pressure, we 

allow the student to copy their data and analyze it later on their own time, with their own computer if 

they wish. 

If the BIOPAC data acquisition unit (MP36/35/46/45) is unavailable or not connected to the 

computer, students may still run the BSL application in “Review Saved Data” mode. This allows full 

analysis of previously recorded data. Many schools using our equipment keep the program and data 

files available on a server for review after the lab session. 

Our lesson procedures contain exercises or tasks to perform for each lesson. These descriptions are 

reflected in the easy-to-follow onscreen Journal while the lesson is running. If the instructor prefers 

to use a different description for a lesson, instruct the students running the lesson to go to “File” 

menu and select “Lesson Recordings” from the “Preferences” option. Then deselect all of the 

Lesson Recording checkboxes. This will turn off the lesson specific text. 

Instructors can then use their own lab manual with the BSL lessons or integrate the BSL Lab Manual 

into theirs (contact the Sales Department at BIOPAC Systems, Inc. for details). 

Instructors may further customize lesson procedures and even onscreen Journal instructions with the 

BSL Curriculum Management System, a licensed feature available in BSL versions 4.1 and higher 

for advanced lesson customization. See page 70 for further details on the Curriculum Management 

System, or contact BIOPAC for more information. 

We understand that the default lessons may not offer the flexibility desired by some users. For more 

complicated operations, we include the Biopac Student Lab PRO software. It is very similar software 

to that used on our Research System, and allows the user to mix and match any of the four channels, 

define the recording parameters and perform advanced analysis. These parameters may be saved as 

graph templates for future recordings. For more details on BSL PRO software, see your BSL PRO 

Tutorial, or the BSL PRO Software Manual. 

Support Materials are available 

Use the Biopac Student Lab Help Menu PDFs and visit the 

Support section of our web site at www.biopac.com for more 

support materials. 

See a demo of the Biopac Student Lab in action here.  

 

 

 

 

 

Please do not hesitate to contact us with your concerns or comments. 

We’re eager to work with you to create total solutions 

for your life science application and research needs. 

http://www.biopac.com/
https://www.biopac.com/video/?video_category=biopac-student-lab&v=bsl-student-download
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Human Anatomy & Physiology Society Position Statement on Animal Use 

(Adopted July 28, 1995, Modified January 2001, Approved April 29, 2012) 

It is the position of the Human Anatomy and Physiology Society (HAPS) that dissection and the 
manipulation of animal tissues and organs are important elements in scientific investigation that introduce 
students to the excitement and challenge of their future careers. HAPS supports the use of biological 
specimens as part of a program of study, provided their use is in strict compliance with federal legislation 
and the guidelines of the National Institutes of Health and the United States Department of Agriculture, 
and that such use fulfills clearly defined educational objectives. 

The mission of the Human Anatomy and Physiology Society (HAPS) is to promote excellence in the 
teaching of anatomy and physiology.  A fundamental tenet of science is the ordered process of inquiry 
requiring careful and thoughtful observation by the investigator. As subdivisions of biology, both anatomy 
and physiology share a long history of careful and detailed examination, exploration and critical inquiry 
into the structure and function of the human and animal body.  

Consistent with the origins and nature of scientific inquiry, HAPS endorses the use of animals as part of 
the laboratory experiences in both human anatomy and human physiology. 

Historically, an important tool of investigation in human and animal anatomy has been dissection. A 
complete anatomy learning experience that includes dissection goes beyond naming structures and leads 
the student to conclusions and insights about the nature and relatedness of living organisms that are not 
otherwise possible. To succeed in their future careers, students must become thoroughly familiar with 
anatomical structures, their design features and their relationships to one another. Dissection is based on 
observational and kinesthetic learning that instills a recognition and appreciation for the three-dimensional 
structure of the animal body, the interconnections between organs and organ systems, and the 
uniqueness of biological material. Dissection conveys the inherent variability of living organisms not 
otherwise observable in simulations and models. Physiology experiments involving humans and live 
animals provide an excellent opportunity to learn the basic elements specific to scientific investigation and 
experimentation. It is here that students pose questions, propose hypotheses, develop technical skills, 
collect data, analyze results and develop and improve critical thinking and problem solving skills 

Since effective teaching requires a diversity of strategies and approaches, HAPS endorses the use of 
computer atlases and simulations, modeling, and video programs to meet educational objectives and the 
needs of students. Science educators choosing not to use animals or biological specimens should choose 
alternatives that are able to convey equivalent anatomical and physiological intricacies to meet their 
educational objectives. 

Science educators have in common a respect and reverence for the natural world and therefore have a 
responsibility to share this with their students. They must communicate the importance of a serious 
approach to the study of anatomy and physiology. HAPS also encourages educators to be responsive to 
student concerns regarding use of animals and to provide students who object to animal use with 
alternative learning materials. 

HAPS contends that science educators should retain responsibility for making decisions regarding the 
educational uses of animals and other strategies and techniques for the betterment of their student’s  
learning. Furthermore, it opposes any legislation or administrative policy that would erode the educator’s 
role in decision making or restrict dissection and animal experimentation in biology. 

Used with permission of:  
The Human Anatomy & Physiology Society (HAPS)  
251 S. L. White Blvd., P. O. Box 2945, LaGrange, GA 30241-2945 
800-448-HAPS (4277)    Fax: (706) 883-8215    www.hapsweb.org 

 

http://www.hapsweb.org/
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IMPORTANT SAFETY NOTICE 

BIOPAC Systems, Inc. instrumentation is designed for educational and research oriented life 

science investigations.  

BIOPAC Systems, Inc. does not condone the use of its instruments for clinical medical 

applications.  

Instruments, components, and accessories provided by BIOPAC Systems, Inc. are not 

intended for the cure, mitigation, treatment, or prevention of disease.  

The MP data acquisition unit is an electrically isolated data acquisition system, 

designed for biophysical measurements. 

Exercise extreme caution when applying electrodes and taking bioelectric measurements 

while using the MP System (MP36, MP35 or MP46/45) with other external equipment that 

also uses electrodes or transducers that may make electrical contact with the Subject.  

Always assume that currents can flow between any electrodes or electrical contact points. 

Extreme caution is also required when performing general stimulation (electrical or 

otherwise) on a subject. Stimulation currents should not be allowed to pass through the heart. 

It is very important (in case of equipment failure) that significant currents are not allowed to 

pass through the heart. If electrocautery or defibrillation equipment is used, it is 

recommended that all BIOPAC Systems, Inc. instrumentation be disconnected from the 

Subject. 
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Setting Up Your Lab 

To set up your lab, you will need the following items: 

• Biopac Student Lab 4 software download. 

• MP36 (or MP35 or MP46/45) Data 

Acquisition hardware, power supply and 

USB cable (included). 

• SSL transducers, electrodes and lab 

materials necessary for running the various 

BSL Lessons. 

• Administrator access to all lab computers. 

Before you begin: 

PLEASE DO NOT CONNECT OR POWER ON YOUR 

MP HARDWARE UNTIL PROMPTED DURING 

SOFTWARE INSTALLATION. THIS MAY RESULT 

IN INCOMPLETE DRIVER INSTALLATION. 

BSL Software & MP Driver Installation 

Windows 

a) Download the Biopac Student Lab installation software from 

the link provided by your BIOPAC representative. 

b) Double-click the  icon in the installation 

folder and follow the installation prompts. The Biopac Student 

Lab program is large (1.5 gb) and this operation may take 

several minutes. 

Windows default installation directory (with C representing the 

main drive):  

C:\Program Files (x86)\BIOPAC Systems, Inc\Biopac 

Student Lab 4.1 

c) When prompted, select the desired MP hardware type(s) being 

used in the lab. (MP36/35/46/45) 

The selected MP driver will be installed or updated automatically. The MP unit(s) must be present and 

ready to connect and power on in order to complete driver installation. (If MP hardware and drivers have 

been installed previously and are known to be current, you may cancel the driver installation and continue 

to step “e”.)  

d) Connect or power on the MP unit when prompted. For more information on physical hardware 

connections and other MP hardware functionality, see page 10. 

e) Follow the remaining prompts to install the KEYLOK license (if required) and BIOPAC Bonjour Service. 

(Bonjour Service is required in order for BSL 4.1 to run properly.) 

If your lab has purchased the optionally-licensed BSL Curriculum Management System, see the license 

activation instructions provided with your license purchase. (Windows only) 

Mac 

a) Download Biopac Student Lab installation software from https://www.biopac.com/4TEACHER16  

b) Double-click the BiopacStudentLab.pkg and follow the installation prompts. 

c) Mac default installation directory: MacIntosh HD:\Applications\Biopac Student Lab 4.1 

d) No driver installation procedure is necessary for Mac OS X. When software installation is complete, 

simply connect the MP hardware to a USB port and power it on. 

Repeat the above installation steps for all additional lab machines.  

https://www.biopac.com/4TEACHER16
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Hardware Connections for Recording 

To acquire data, the MP Data Acquisition Unit must be connected to the computer and the correct electrodes, 

transducers, and/or I/O (Input/Output) devices must then be connected to the MP unit. These connections will 

vary from lesson to lesson. You are encouraged to take a few minutes to familiarize yourself with the MP 

unit’s front and rear panels prior to making any connections. 

The front panel of the MP36/35 has an electrode check port, four analog input ports, and two status indicators. 

   

MP3X Front Panel 

The channel input ports are on the front of the MP acquisition unit and are labeled CH 1, CH 2, CH 3, and CH 

4; the MP46/45 is CH 1 and CH 2 only. The BIOPAC Simple Sensors are connected to these inputs as 

directed by the lesson procedures. The Biopac Student Lab software will always check to see that you have 

the proper sensors connected for a particular lesson. (See following page for Simple Sensor information.) 

The “Electrode Check” port is a diagnostic tool not required for most lessons, but is used optionally in EEG 

Lessons 3 and 4 to check signal quality prior to calibration.  

The back panel of the MP36/35 has an analog output port, a USB port, a 3.5 mm headphone input, an I/O 

Port, a Trigger Port, a DC input, a fuse holder, a power switch, and the unit’s serial number.  

 

MP3X Back Panel 

The Analog Out port on the back of the MP Unit that allows signals to be amplified and sent out to devices 

such as headphones. 

NOTE: The 2-channel MP46/45 data acquisition unit does not support triggering or electrode check, and has 

a 3.5 mm headphone jack in place of an I/O port. 

Connecting Devices to the MP Unit 

There are three types of input devices that connect to the MP Acquisition Unit as an interface between the 

subject and the hardware: electrodes, transducers, and I/O devices. 

Electrodes are adhesive pads that attach to the surface of the skin and 

gather electrical signals from the body. Depending on where 

electrodes are placed, different signal types will be picked up and sent 

to the MP unit, where they are amplified and sent to the computer and 

the Biopac Student Lab software. 

Electrode lead cables connect to the electrodes, directly attached to 

the subject’s skin and record biopotential signals directly from the 

body. 

It is critical that the electrodes be properly applied to the Subject.  

Poor electrode contact with skin = poor data. On the first day of  lab 

requiring the use of electrodes, instructors should emphasize and 

demonstrate proper skin preparation and electrode placement. See the 

Lesson Procedures for guidance on proper application of electrodes. 

 

Electrode lead cable clip and 

electrode 
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Transducers are hardware that plug directly into an MP unit’s channel input and convert a physiological 

parameter to a proportional electrical signal. An example of this would be the SS5LB Respiratory Transducer, 

which is a bow-tie shaped transducer attached to an elastic band positioned around the Subject’s chest. The 

transducer records the expansion and contraction of the Subject’s respiration cycles. 

  

The resulting data is plotted in real time in Biopac Student Lab, where it appears as a waveform in the Lesson 

graph. 

I/O devices are specialized input/output devices (I/O for short), such as push-button handswitches and 

headphones. The push-button handswitch connects to the front panel of the MP Unit, whereas headphones 

connect to the Analog Out port (or 3.5 mm headphone jack depending on headphone type) on the back panel 

of the MP Unit. 

Using Simple Sensors 

Every electrode lead, transducer, or I/O device connects 

to the Biopac Student Lab MP acquisition unit using a 

“Simple Sensor” (SSL) connector. The Simple Sensor 

connector is designed to plug it into the MP Unit on 

way only, so it’s not possible to plug the connector in 

upside down. It’s not necessary to tighten the 

thumbscrews on either side of the connector. This 

makes it easy to change a lesson set up and experiment 

with different transducers. 

 

Input connection to the MP UNIT 

 

Simple Sensor Connector 

For full technical details about MP hardware, transducers and electrodes, see the BIOPAC BSL 

Hardware Guide.pdf (in the Biopac Student Lab 4.x > ‘User Support’ folder).  
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Launching the BSL Lessons Program 

Windows 

Double-click the Biopac Student Lab 4.1 Desktop shortcut (or click “Start > All Programs” 

and navigate to the Biopac Student Lab 4 program.) 

Mac OS X 

From the Finder, choose “Go > Applications > Biopac Student Lab 4.1” and double-click the BIOPAC BSL 

4.1 icon. 

The BSL Startup Wizard 

Biopac Student Lab Lessons and the full Biopac Student Lab PRO application are installed at the same time 

and both are selectable in a main Startup Wizard window (below right). The “Startup Wizard” window 

appears by default when the BSL application is launched, and is a “gatekeeper” interface to all BSL Lesson 

and BSL PRO functionality. Let’s look at the main “What would you like to do?” startup options. 

Record or Analyze a BIOPAC Lesson – 

this is the default Startup selection and 

presents the BSL Lessons menu and Review 

Saved Data (analysis) mode. The PRO 

Lessons tab reveals a menu of advanced 

curriculum lessons 

Create/Record a new experiment – 

Selecting this option launches the application 

into BSL PRO mode, with advanced data 

acquisition and analysis functionality. 

If preferred, the Startup Wizard can be 

bypassed, and the application can be 

launched directly to an empty graph window 

(BSL PRO) or to the “classic” Lesson menu 

(BSL Lessons). To access this preference, 

choose “Create/Record a new experiment > 

Display > Preferences > Other” and select the 

desired launch option (below). 

 

Note that each side of the application must be 

run individually—it is not possible to run 

BSL Lessons and BSL PRO at the same time. 

For the purposes of the following user interface overview, we will use the Startup Wizard navigate to a 

sample data file. 

1. With “Record or Analyze a BIOPAC Lesson” selected, choose “Review Saved Data” and click OK. 

2. Browse to C:\Program Files (x86)\BIOPAC Systems, Inc\Biopac Student Lab 4.1\Sample 

Data\English – en  

3. Choose “SampleData-L07” and click OK. (MP hardware is not necessary to run in analysis mode.) 

For an overview on running a lesson, see the “Experimental Methods” section on page 34. 

To open a sample data file in BSL PRO analysis mode, which displays the maximum available toolbars and 

menu options, choose “Open a graph file” > “Sample data file,” select the desired sample data file and click 

OK. Using this file opening method offers access to all BSL PRO functionality. For a summary of PRO 
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features, see page 67. For detailed information on BSL PRO functionality, see the BSL PRO Tutorial under 

the Help menu of the PRO application or in the User Support folder. 

Graph Window and Lesson User Interface 

The Biopac Student Lab software generates two basic display windows: Graph Window and Journal. 

 

Biopac Student Lab Graph Window and Journal (SampleData-L07) 

The graph window displays the waveform channels during or after recording. Up to eight waveforms 

(channels) can be simultaneously displayed, as controlled by the software and lesson requirements. 

The Journal contains lesson text, measurements, tables, links or graphics, which can then be copied to 

another document, saved or printed. The Journal can be shown or hidden by toggling the “Show/Hide 

Journal” button on the graph window toolbar. By default, the Journal appears at the bottom edge of the graph, 

but can also be docked at any edge of the graph window, or be free-floating. To set this option, go to Display 

> Preferences > Journal > Display Style (This preference must be accessed in BSL PRO “Create/Record a 

new experiment” mode.) 

Graph window functionality and menu options vary by software mode and is detailed in the following section. 
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BSL Lessons Menu Options 

The BSL Lessons Menu functionality varies by mode as shown below. 

Menu Calibration Recording Mode Analysis Mode 

File  Prior to calibration (when 
lesson is launched) or after 
“Redo calibration is 
selected: 

 

During calibration: 
  No menus available. 

After calibration:  

 

(File menu not available 
during or immediately after 
suspending recording) 

 

 

 

Edit  

 

Not available during 
Calibration. 

 

 

Not available in this mode. 

 

Display 

 

 

 

Not available during 
Calibration. 

  

Help 

 

On the Mac, “About…” info 
is under the Biopac 
Student Lab menu. 

 

On the Mac, “About…” info 
is under the Biopac 
Student Lab menu.  

 

On the Mac, “About…” info is under 
the Biopac Student Lab menu. 
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Menu Calibration Recording Mode Analysis Mode 

Lessons 

  

Data from the recording 
must be saved before the 
Lessons menu can be 
activated. 

• Menu is only available in 
lessons with multiple 
recordings and only after 
the “Stop” button has 
been pressed. 

• In lessons with only one 
recording, use the 
“Done” button option to 
Record another lesson. 

 

 

Analysis Mode menus available in Advanced Lesson Preferences 

BSL PRO-style Transform and an FFT Analysis menus can be added to Lessons Analysis Mode by modifying 

the BSL PRO Advanced Lesson Preferences. See page 24 for more details. 
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Lesson Graph Window Functionality 

BSL Lessons display and graph control functionality varies by the  three modes as shown below. 

FUNCTION CALIBRATION RECORDING ANALYSIS 

“Review Saved Data” 

Measurement Normally off. Defaulted to “none” and 

normally not used. If 

required, the lesson will give 

detailed instructions for use.  

Initially defaulted to “none.” 

User must select tools 

required for Analysis and 

Data Report. 

Data Window User does not control. Display is set by the lesson 

macro; user does not control. 

User sets display options for 

waveform measurements (for 

up to eight waveforms, as 

determined by the software 

and/or required for the 

lesson). 

Grids Automatic when required by 

lesson; not controlled by user. 

Automatic when required by 

lesson; not controlled by user. 

User can Show, Hide or 

reformat the grid display. 

Journal Read only. Read only. Guides user 

through recording steps. 

Becomes a text editor for text 

and measurement data. 

Preferences Must be set prior to 

calibration; see page 16 

Not available. Not applicable. 

Printing Not available. Not available. All print options available. 

Event 

Markers 

Not available. Automatic for most lessons, 

user can insert and edit as 

required. 

User can insert and edit. 

Save Not available. Automatically saved when 

“Done” button is pressed. 

User activated Save options. 

X-axis/Y-axis 

Scales 

Not controllable. Not controllable. Vertical and Horizontal 

Scales are adjustable (using 

Lower/Upper settings) 
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Lesson Preferences 

Preferences are lesson specific and are saved independently for each lesson, as follows: 

  INCLUDED IN LESSON ("X" indicates the preference is included))  

PREFERENCE 1 2 3 4 5 6 7 8 9 10 11 11A 12 13 14 15 16 17 20 

BP Cuff Type                 X   

Calibration Syringe 

Values 
           

 
X X      

Calibration Syringe Size             X X      

Cardiac Signal         X           

Clench Force Transducer  X                  

ECG Filter     X X              

ECG Lead II Data                 X   

Grids X  X X X X X X X X   X X X X X X X 

Gauge Color                 X   

Headphone Volume           X         

Light Intensity            X        

Heart Rate     X X X             

Lesson Recordings X X X X X X X X X X X X   X X X X X 

Residual Volume             X       

Respiration Transducer        X X           

Response Options                   X 

Resting Skin Temp.                X    

SS11LB Calibration 

Option 
           

 
X X      

Temperature Scale                X    

Time Scale     X               

Establish Lesson Preferences before calibrating or recording data. 

Preference settings are stored on the local computer. To ensure that all students use the same Preference 

settings, you must establish the Preferences before any student begins recording. Any changes to the 

Preference settings are preserved until manually changed. Limited/Restricted user accounts will run using 

Preference settings established under the Administrator account. 

To change a Lesson Preference: 

1. Open a lesson from the Startup Wizard “Choose a lesson” menu or from the “Lessons” menu of an 

open lesson file. (Lesson 1 – EMG is used in this example.) 

2. Click on the File menu and select Lesson Preferences.  

 

3. Select a Preference option to change and click OK to generate the settings dialog. 

    

4. Choose an option and click OK.  
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IMPORTANT! 

Lesson Preferences are saved when you click OK in the Preference setting dialog, whether or not you record 

or save the lesson. They do not default back to the factory settings once they have been modified and saved. 

This makes it easy for instructors to establish custom Preferences for each lesson based on the lab setup and 

equipment the students will use; when students open a lesson, the Preferences established by the instructor 

remain intact. 

It is important that the instructor properly set up all of the Lesson Preferences before the application is 

launched by any user account that does not have WRITE access to the default preference file locations. This is 

because under this condition, the application will, upon the first launch of a lesson, copy the preference file -  

from 

Main Drive:\Program Files (x86)\BIOPAC Systems, Inc\Biopac Student Lab 4.x\LessonsSupport\all-

lang 

to 

C or main drive:\Documents and Settings\All Users\Documents\BSL Lessons\Lesson Preferences 

Various Lesson Preference Types  

PREFERENCE EXPLANATION 

Blood Pressure Cuff 

Type (L16) 

 
Select between standard SS19L cuff sphygmomanometer, or SS19LB/LA, which 

supports onscreen BP gauge. 

Calibration Syringe 

Size (L12, L13) 

 

Calibration Syringe 

Values (L12, L13) 

 
Calibration of the syringe assembly can be required only once per session or repeated 

each time the lesson is launched. (This procedure must always be repeated upon fresh 

launch of the application) 

Cardiac Signal Type 

(L09) 

 
Choose between ECG or PPG (Pulse) signal type, depending on transducer used. 
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PREFERENCE EXPLANATION 

Clench Force 

transducer (L02) 

 
Choose between SS25L hand dynamometer or SS56L bulb transducer. 

ECG Filter (L05, 

L06) 

  
There are multiple ECG filter Preferences so you can select filtering appropriate to the 

artifact in your lab. The default (0.5-35 Hz with a 50/60 Hz filter) is set for maximized 

filtering so that if students do not read this description and/or do not understand 

filtering issues, results will still be reasonable. As you move down the Preference 

options, filtering is decreased.  

About ECG filtering 

Most of the frequencies of the ECG signal are in a band from 0 to 150 Hz. 

Unfortunately, other signals present on the body can also contain frequencies in this 

band. These other signals, known as “artifact,” can distort the ECG signal. 

Three of the main sources of ECG artifact are: 

c) EMG (muscle) signals (10 to 5,000 Hz) 

c) Line frequency signals induced onto the body from wires carrying 

electricity (50 or 60 Hz) 

c) Electrode offset potentials (0 to 1 Hz), known as “baseline drift,” 

caused when electrode contact with the skin varies (due to poor 

electrode contact, electrode strain, etc.). 

The most common way to get rid of the artifact is to use electronic filters to block the 

frequencies of the artifact but pass other frequencies in the ECG band. This, however, 

is a tradeoff because the filters may remove some of the desired ECG frequencies, and 

the filters themselves can cause small distortions in the ECG signal. 

The amplitude of the ECG components is not important in many analyses, so filtering 

is acceptable. Lessons 5 and 6, however, look specifically at the amplitude of the ECG 

components, so filtering needs to be minimized as much as possible, which means that 

the ECG artifact must also be minimized if you want a clean signal. 

Factors influencing artifact will vary from lab to lab and subject to subject, depending 

on the lab layout, attention to detail when attaching electrodes and cables to the 

subject, and the degree of subject movement during recording. It may take some 

experimentation to determine the best setting for your lab. 

ECG Lead II Data 

(L16) 

 

Provides an option to show or hide ECG data channel. 
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Gauge Color (L16) Choose blue or background with contrasting dial. 

    

Grids 

(All lessons except 

L02, L11, L11A) 

 

The grid is a series of horizontal and vertical lines that create a visual guide to find data 

positions with respect to the horizontal and vertical scales. Grids provide a quick visual 

guide to determine amplitude and duration.  

 

Most lessons include the Grids Preference. The Show/Hide options control grid display 

during recording; grids are not applied during calibration. If you record with grids off, 

you can still show grids in the analysis mode via the Show Grid/Hide Grid toolbar 

buttons.  

Headphone Volume 

(L11) 

 

 

Use to adjust the volume level of the “click” generated in Lesson 11. 

Heart Rate Data 

(L05, L06, L07) 

 
 

Lesson Recordings 

(All lessons except 

L12, L13) 

 
Enables default lesson recordings to be selected or deselected as desired. Use this 

option to present an abbreviated subset of lesson recordings. 
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Limiting Lesson 

Recordings and 

suppressing default 

Journal Text (All 

lessons except L12, 

L13) 
 

The minimum amount of HTML Journal text can be shown by deselecting all available 

lesson recordings and clicking OK.  

 

 Default Journal text option (at least one lesson recording must be selected) 

** Showing only the minimum amount of Journal text hides all lesson specific text and 

shows only the software control text (button functions, recording time, etc.). No 

Marker text will be displayed, and Journal functions in the Review Saved Data 

mode will be limited. 

Use this if you have written your own lab procedure and want students to follow 

your separate instructions. 

 

Journal text with no lesson recordings selected 

For detailed customization options, use the Biopac Student Lab PRO software (see 

page 67 for details). For advanced lesson customization options that exceed the scope 

of standard lesson customization, see the BSL Curriculum Management System 

(licensed functionality), details on page 70. 

Light Intensity 

(L11A) 

 

Use to adjust the brightness level of the LED blink generated in Lesson 11A. 
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Residual Volume 

(L12) 

 

  

 

Residual Volume (RV) cannot be determined using a normal spirometer or airflow 

transducer, so the Biopac Student Lab software lets you enter this value manually. The 

default setting is 1 Liter. The maximum value is 5 Liters; a warning dialog will appear 

if a value greater than 5 Liters is entered. 

Response Options 

(L20) 

 

Used to select the response type transducer for measuring leg movement in Lesson 20. 

Resting Skin 

Temperature (L15) 

 

 

The BIOPAC thermistor (SS6L) accurately measures temperature in relation to a 

starting value (the assumed resting skin temperature). For Lesson 15, the relative 

temperature is sufficient, so calculations using the assumed value are fine. If absolute 

accuracy is required, enter an accurate starting value (from a digital thermometer or 

other temperature device) rather than using the assumed value. 

Respiration 

Transducer (L08, 

L09) 

 

 

Specify the SS5L model number; settings will be optimized for your selection. 

SS11LB Calibration 

(L12) 

 

Use to set calibration preferences if SS11LB Airflow Transducer is used. 
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Temperature scale 

(L15) 

 

 

The vertical scale will display your selection. 

Time Scale (L05, 

L06) 

 

Use to set the length of the visible horizontal time scale in the lesson (x-axis). 
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Lesson Customization Options 

Setting which Lessons appear in the Program (Showing/Hiding Lessons) 

Lessons can be shown or hidden as desired in the BSL PRO application preferences. If certain lessons aren’t 

to be used in a particular curriculum, they may be “removed” from the Startup Wizard or Lessons menu via 

the following steps: 

1. Launch the BSL PRO application (choose “Create/Record a new experiment in the Startup Wizard). 

2. Go to Display > Preferences or click the “Preferences” toolbar button . 

3. Select “Lessons” in the Preferences menu. 

4. Simply check or uncheck lessons as desired and click OK. Unchecked lessons will not appear in the 

startup menus. 

 

NOTE: Unless the optional BSL Curriculum Management System is installed, modified Lessons preferences 

apply to the local machine only and must be performed on each workstation. 

Global Lesson Preference Settings – BSL 4.1.3 and higher: 

In BSL 4.1.3 and higher, many default BSL Lessons Global Preference settings for can be easily modified to 

include enhanced functionality. This is accomplished by selecting the desired options in the BSL PRO 

“Advanced Lesson Preferences” dialog. To access the Advanced Lesson Preferences: 

1. Launch the BSL application and select “Create/Record a new experiment” in the Startup Wizard. 

2. Go to Display > Preferences > Lessons and click the  button to launch the 

Advanced Lessons Settings setup screen: 
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The following Advanced Lessons Settings controls are available: 

Transform 

Access in 

Review Saved 

Data: 

Adds the BSL PRO Transform menu and FFT analysis* to BSL Lesson files opened in 

Review Saved Data mode. 

Access to File > 

Lesson 

Preferences: 

Controls whether students have access to the BSL Lesson Preferences menu item while 

running a lesson. 

Save recorded 

data to: 

Controls whether lesson files are saved to the default Data Files folder or to a user-defined 

location. Choosing “Custom location” enables the “Change” button for choosing the new 

Save location. 

Initial location 

for Copy: 

Controls where the BSL Lessons “Copy to another location” option saves the copied file.  

“Last graph save directory” saves the copy to the most recent location the data file was 

saved to. 

Choosing “Custom location” enables the “Change” button for choosing a new “copy to” 

location. 

Default journal 

font: 

Selects the default font used for all lesson journals. 

Allow e-mail as 

graph 

attachment: 

Controls whether students have access to the BSL Lessons “File > Email graph as 

attachment” menu item. 

Initial journal 

size: 

Sets the default Journal size to maximized or minimized for the Lesson file under 

analysis. 

Save a copy 

as… 

Creates a file containing a copy of all selected Lessons preferences. This file can be 

opened in Notepad or any other text editor. It can also be used as a lesson preference 

setting file for adding PRO functions to the BSL Analysis-only version. 

Save Saves all selected settings and applies them to all subsequent BSL Lesson files opened in 

Review Saved Data mode. Note that modified settings are not applied until the BSL 

application is closed and relaunched. 

 

Cancel Dismisses any modified settings without applying them. 

*For details about the Transform menu and FFT analysis, see the BSL PRO Manual. 

 

 

To modify global lesson preference settings in BSL versions 4.1.2 and earlier, see the next section.
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Global Lesson Preference Settings – BSL 4.1.2 and earlier: 

To modify the default Lessons preferences in BSL 4.1.2 and earlier, it’s necessary to manually edit the BSL 

Lessons global Preference text file (LessonPrefSettings.txt) which holds the instructor-established Preference 

options. This Preference file can be found here: 

Main Drive:\ProgramData\BIOPAC Systems, Inc\Biopac Student Lab 4.x\LessonsSupport\all-lang 

The instructor can either allow or disallow student access to the Preference settings. 

Instructor Editable Variables for lesson customization 

Show or hide lessons in menus and Startup Wizard (see above) 

Review Saved Data Mode options (add BSL PRO functionality) 

Preference menu (lock lesson setup so students follow your Preferences) 

Location for saving lesson data file 

Location for “Copy to another location” function 

Font style for journal text display 

Modify Journal Data Report content (*.jcq files) See Data Report, page 41. 

Turn ‘Email Graph as Attachment’ on or off 

These customization features allow you to choose the program features to display as menu options. If you 

have a specific procedure in mind, you can limit the menu options to list only those functions you need, 

thereby reducing the chances for confusion or error. For instance, you might choose to remove the 

Preferences option to lock the setup to your established protocol. With simple text editing of the startup 

script, you can control the program features accessible to your students. You can show or hide the 

Preferences menu and can control the analysis functions available in Review Saved Data mode by allowing 

basic BSL functions or BSL PRO functionality. 

Preferences Menu 

  Or   

Review Saved Data Mode 

 Or   

 

Customizing Preferences (BSL 4.1.2 and earlier) 

Follow this simple procedure to customize menu display for your own needs. 

1. Navigate to the LessonPrefSettings.txt file. 

• Windows default: Drive>:\Program Files\BIOPAC Systems, Inc\Biopac Student Lab 

4.x\LessonsSupport\all lang 

 

• Mac default installation: Finder > Applications\Biopac Student Lab 4.x. 

o Highlight “Biopac Student Lab 4.x” and choose “Show Package Contents”. 

o Browse to LessonsSupport\all lang\ 
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2. Open the BSL Lessons folder.  

 

 

3. Copy the LessonPrefSettings.txt file as follows:  

a.) Right-click and scroll to select “Copy.”  

b.) Right-click and scroll to select “Paste.” 

 

4. Windows users: choose a compatible text editor and right-click to choose “Run as 

administrator” to enable required save permissions. 

 

Sample errors for Windows OS when not opening or saving 

as “administrator” 
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5. Open the original LessonPrefSettings file (“Copy of LessonPrefSettings” is for backup) with a 

compatible text editor.  

 

Windows OS: Microsoft WordPad or Notepad 

Mac OS: To edit the LessonPreferences file on a Mac, you 

must use a text editor that will retain the type/creator code 

“AcqP/AcqS” when saving the file; the application will not 

recognize preference files without this type/creator code. 

• TextWrangler™  from Bare Bones Software, Inc. is a 

compatible freeware text editor.  

http://www.barebones.com/products/textwrangler/index.s

html 

• If the type/creator code is lost, use ResEdit or another 

Macintosh resource editor to manually set the code.  

6. Follow the instructions provided in the LessonPrefSettings file (as shown on the following 

page) to change the Instructor Editable Variables. 

* The LessonPrefSettings or Startup script is sensitive to syntax errors, font change, name 

change, etc., so be extremely careful not to change anything except the “1” or “0” on the line 

that contains the menu item you want to change. 

*  Remember to use File > Save (not Save As!) to save your changes so the script file 

name is exactly the same — the program will not recognize an altered file name. 

* Select File>Save to save the revised Startup file. 

* If you receive an “access denied” prompt when attempting to save the LessonPrefSettings.txt 

file, reopen the file by right-clicking it and choose the “Run as administrator” from the 

contextual menu before modifying and saving it. 

*  DO NOT USE the “SAVE AS” option. 

*  Restart the BSL 4 program. 

7. Check your menu listing. 

* The menus on page 26 show the result of changing the Review Saved Data Mode Options 

and the Preference Menu Option per step 6 above. Note that the Preferences option is no 

longer included in the menu listing (rather than simply being disabled and grayed-out). 

8. If you have the desired menu result, you may delete “Copy of LessonPrefSettings.txt” from the 

program folder. 

 

http://www.barebones.com/products/textwrangler/index.shtml
http://www.barebones.com/products/textwrangler/index.shtml
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LessonPreferences file – BSL 4 
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Changing the Default Location for Saving Lesson Data Files (BSL 4.1.2 and earlier) 

The default path used by BSL for saving Lesson data files is: Drive:\Users\Public\Documents.  

If desired, the default save path can be changed by making some simple edits to the “LessonPrefSettings.txt” 

file. Note that in order to edit this file, Administrator privileges are necessary. 

To change the default lesson file path: 

1. Decide where you would like the lesson data files to be saved and create a folder in that directory.  

2. Browse to the “LessonPrefSettings.txt” file in Program Files: 

Drive:\Program Files (x86)\BIOPAC Systems Inc\Biopac Student Lab 4.1\LessonsSupport\all-lang\ 

 

3. Double click the “LessonsPreSettings.txt” file to open it in Notepad (or any text editor). 

4. Change the “Location for saving data files” value  to “1” as shown below example. 

5. Enter your new file path into the space below the “Fixed path for saving data files…” line. (Note that 

the file path shown below is for example purposes only. Your file location may be different.) 

 

6. Choose “File > Save” or Ctrl+S to save the changes.  

On subsequent BSL launches, all completed lesson files will be saved in the new location in a subfolder titled 

“Data Files.” (This folder is automatically created by BSL, regardless of main folder location.) 
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If saving the lesson files to a location over a network, it it recommended to first save the files to a local hard 

drive, then instruct the students to choose the “Copy to another location” option at the end of the lesson. 

Saving initially to a local hard drive will create a backup copy of the lesson files in the event of a network 

problem. 

 

 

To change the “Copy to another location” path: (BSL 4.1.2 and earlier) 

1. Double click the “LessonsPreSettings.txt” file to open it in Notepad (or any text editor). 

2. Change the “Copy to another location” value  to “1” as shown below example. 

3. Enter your new file path into the space below the “Fixed path for saving data files…” line. (The file 

path shown below is for example purposes only. Your file location may be different.) 

 

4. Choose “File > Save” or Ctrl+S to save the changes.  
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Access to Lesson Procedures and Intro PDFs 

During Lesson recording and analysis, the associated Lesson Procedure, Intro and Analysis procedure are 

available in the Lesson’s Help menu. Lesson Procedure PDFs are also accessible via the following methods: 

▪ From the Help menu of any Lesson file opened via ‘Review Saved Data’ in the BSL Startup Wizard. 

▪ By selecting the ‘Help” radio button in the BSL Startup Wizard. 

▪ By browsing directly to the ‘User Support System’ folder: 

Windows: Drive:\Program Files (x86)\Biopac Systems, Inc\Biopac Student Lab 4.x\User Support System 

Mac OS X: Finder:\Applications\Biopac Student Lab 4.x\User Support System 
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 Recording Mode Basics and Lesson Structure 

Recording mode functions are detailed in each lesson procedure and lesson Journal. The structure of the 

supporting lesson text is explained below, and at the end of that section, there is an overview of display 

options applicable in the Recording mode. 

Each Biopac Student Lab lesson provides an overview of  the specific area of Physiology that can be recorded 

using the Biopac Student Lab system.  

IMPORTANT — Use the free Biopac Student Lab Analysis Only (RSD) Software to 

review and analyze data files use on your personal computer, outside the lab; the MP 

UNIT does not have to be attached. Download available at www.biopac.com. 

Each lesson includes the following sections: Introduction 

 Experimental Objectives 

 Materials 

 Experimental Methods 

 — Set up 

 — Calibration 

 — Recording 

 Data Analysis 

 Data Report 

The Biopac Student Lab was designed to make setup and calibration quick and easy, with the intention of 

allowing each student in the group to rotate to be the recorded Subject within a lab period. The way to do this 

is to collect data from a Subject, then switch to a new Subject at the end of the recording section and repeat 

the Calibration and Recording sections. This continues until all students have been the Subject. 

Introduction 

The Introduction is a refined presentation of the physiological concept addressed in the lesson. The 

Introduction should assist you with concepts and definitions needed for the Analysis and Data Report, but is 

not intended to be a substitute for your textbook. The main objective is to give you the proper information to 

collect good data. 

Experimental Objectives  

The Experimental Objectives summarize the principles demonstrated in the Lesson. For a complete list of 

Experimental Objectives by lesson, see page 63. 

Materials 

The Materials list contains everything necessary to perform the Lesson. This is not just a list of BIOPAC 

equipment, but includes items such as rulers, protractors, bucket of water, etc. required to complete the 

Lesson. Check the equipment list prior to beginning a recording. 

In addition to the lesson-specific materials, some instructors have found the following items useful when 

performing Biopac Student Lab experiments: 

Ruler 

Measuring tape 

Step stool 

Pillow with paper covers 

Cotton balls 

Protractor 

Calculator 

Storage boxes 

Head bandage for EEG 

Additional rainbow construction paper (PAPER1) for ED
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Experimental Methods 

Experimental Methods contains the Set Up, Calibration, and Recording sections. Each section is presented in 

a two-column format, as described below: 

FAST TRACK 

This side of the lesson (left, shaded 

column) is the “FAST TRACK” 

through the lesson, which contains a 

basic explanation of each step. 

Detailed Explanation of Steps 

This side of the lesson contains more detailed 

information to clarify the steps and/or concepts in the 

FAST TRACK, and may include reference diagrams, 

illustrations, screen shots, and/or references to this 

manual. 

Although it is not absolutely necessary, BIOPAC recommends that students work in groups of at least three. 

Students should choose a Director, a Recorder, and a Subject from their lab group before beginning Set Up 

(which often involves the Subject). 

Director: The Director reads the lesson steps and tells the Recorder and Subject what to do. The Director 

also keeps track of the length of time for each condition. 

Recorder: During the recording session, the Recorder will insert a marker (press F9) whenever the 

Subject is requested to do something and will key in the condition to create the marker label. 

The recording step will indicate what to key in. Note that marker text can be added or edited 

after the recording is complete. 

Subject:  This is the person from whom data will be recorded. The Subject will need to perform the 

tasks as instructed by the Director. It is suggested that the Subject not look at the computer 

screen while data is being recorded, as there tends to be a “biofeedback” effect that can bias 

the heart rate. 

Set Up 

Set Up explains how to connect transducers and electrodes to the MP acquisition unit and to the Subject. You 

should follow the figures provided. 

Starting the Biopac Student Lab program 

To START the Biopac Student Lab 4 program, simply click on the Desktop shortcut and choose a lesson. 

 

Start the BSL program 

 

 

 Note: You can select the language version to install (English, Español, or Français). Language 

versions contain translated menu items, screen prompts, dialogs, etc. You can install multiple 

language versions on your computer (but only one program may be open at a time). Full translation 

requires the corresponding Operating System with appropriate ‘Regional Settings.” 

To change settings, open the “Regional settings” or “Region and language” dialog as follows:  

 

 Adjust Location (Country) to Spanish →Spain (traditional) or French→French (standard) 

and click OK. See the Installation Guide for more detailed instructions. 
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Choosing a Lesson 

After launching the application, click a lesson to select it (scroll down to see full list) and then click OK. If 

the MP unit is not ON or is not properly connected, the message below right will be displayed. Check the MP 

device power switch and connections, then click “Retry.” 

  

Type in a file name 

Upon selecting a lesson, a prompt for creating a file 

name will appear. Type in a unique identifier and click 

OK. 

 

 

 

The Biopac Student Lab software doesn’t allow for duplicate names, so if a lot of other students are using the 

same computer, the Biopac Student Lab software may prompt for a different name. Appending a number or 

letter to an existing name is a good solution to this problem. 

 

To save to the existing folder, select Use it. This is a convenient way to ensure that a student’s lesson files for 

the class term are stored in one folder.  

 

Each folder can contain up to 10 recordings of 

the same lesson. If 10 recordings are exceeded, 

the folder name prompt will appear. 

 

Data files inside a folder can be moved, duplicated or copied to a flash drive as a backup or to be viewed later.  
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Calibration 

 

For each lesson, a calibration cycle is required to establish the internal hardware parameters (such as gain, 

offset and scaling) of the MP acquisition unit and is critical for optimum performance. It’s important to pay 

close attention to the calibration procedure, which in most instances require only eight seconds. (The 

calibration can be easily repeated if the results are not within the expected limits.)  

Calibration procedures for all BSL Lessons are assisted by onscreen instructions in the Lesson’s Journal. The 

Lesson Procedure PDFs in the Help Menu also fully explain the calibration procedures. This helps assure 

optimal data accuracy with no guesswork. 

If the Subject must respond in some fashion during the calibration, a prompt will appear on the computer 

screen describing the desired action (i.e., inhale deeply when a beep tone is heard).  

Lessons 3 and 4 (EEG-1 and EEG-2) include an optional step to “Check Electrode Impedance” prior to 

Calibration to assure that scalp electrodes are properly attached. See Lesson Procedures for more details. 

Sample calibration graphs are provided in the lesson text so you can check your calibration data. Your data 

may not match the sample precisely, but key points will be indicated, and if your data matches these key 

points you may not have to redo calibration. 

Recording 

 

The recording phase follows the calibration phase. During the active recording phase, the lesson Journal 

instructions will guide the Subject through the necessary steps required by the lesson.  

The Journal instructions are very detailed and include sample screen shots and embedded videos for 

comparison—so, even if the Subject doesn’t  fully understand the science behind the lesson or in under a 

time constraint, it’s still easy to obtain meaningful data. Important concepts are often made clear after the 

lesson during the Analysis section. 

In each lesson, there are multiple data segments that need to be recorded, with different tasks occurring during 

and/or between these segments. It’s helpful to read ahead to the next step in the lesson so it is clear what 

task(s) are required during each recording segment. 

Factors to consider for the recording mode:  

* Clicking Suspend will pause the recording, allowing time to review the data and prepare for the next 

recording. Once selected, the Suspend button changes to a Continue button.  The Continue button is a 

gateway to the Record button for the next recording segment.  

* The Redo feature is very handy and should prevent panic from setting in following a less-than-great 

recording. It’s easy to redo a recording segment if something goes wrong or if the proper tasks were not 

performed. 

* Printing is only available in the Review Saved Data analysis mode — it is not available in the recording 

mode. 

* Grids cannot be turned on while in recording mode; if the recording requires grids, they will be turned on 

automatically. 

* Some lessons utilize a sound event. Sound events can be controlled via the Control Panel Sounds dialog 

(Start > All Programs > Control Panel > Sound/Sounds). Select “Default sound” and the desired “Name” 

for the sound.  

If a computer does not have a sound card installed, or cannot play the default sound event for any other 

reason, the beep will be generated through the computer’s internal speaker. 

Done button options 

After completion of all recording segments, click Done to generate the following options: 
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Dialog options after pressing “Done”  

Record from another subject 

Return to the first screen of the lesson. Repeat the necessary set up, type in a new Subject name, and 

repeat the entire recording. Depending on the lesson, the calibration may need to be repeated.  

Analyze current data file 

Switch to the “Review Saved Data” mode and automatically open the last recorded data file. 

Analyze another data file 

Switch to the “Review Saved Data” mode to open a data file for review. 

Record another Lesson 

Generate the Lessons menu. 

Copy to another location 

Generate a Save dialog to designate the location to save the file to. Note that the file name cannot be 

changed. 

▪ Use the Lesson Customization Options (detailed on page 26) to designate the default file 

location for “Copy to another location.” 

Copy to Dropbox 

 Copy the file to an online Dropbox account. (A Dropbox account is necessary to use this feature.) 

Go to Startup Wizard 

 Exits the current lesson to the Startup Wizard. 

Quit 

Closes all open lesson windows and exits the Biopac Student Lab application. 
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Data Window Functions in the Recording Mode 

Grids 

A grid is a series of horizontal and vertical lines 

that assist the eye with finding data positions with 

respect to the horizontal and vertical scales. Grids 

can be fixed or variable. A fixed grid has grid lines 

locked to the data. When fixed grids are on, the 

horizontal and vertical scale adjustments are locked 

out, but the user may still use the zoom options. In 

general, any lesson that records an ECG signal will 

use fixed grids, but there are exceptions to this. 

Grids will appear in the recording mode of selected 

lessons, to assist the user in obtaining certain 

values (like the grip strengths required in Lesson 2 

EMG II). Grids will only be displayed in the recording mode when they are absolutely needed, so the 

waveform can be more clearly displayed. 

 

Event Markers 

Event Markers are used to reference important locations in the data. Markers are the inverted triangles that 

are placed within the marker region and each can have marker label text. The lessons specify when to place 

markers during the recording, and you can add or edit markers during analysis. The specific elements of 

markers are shown below: 

 

Event Marker elements 

To insert a marker while the data is being recorded, press the F9 key. (ESC in Mac) 

You may then type in text, which will be linked to that marker, but which is displayed in the left portion of 

the marker region.  

The “active” marker appears darkened, and the marker text corresponds to the active marker (“exhale” in the 

figure above). You may change the active marker by using the “marker tools” in the right portion of the 

marker region (see figure above). 
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Journal Functions in the Recording Mode 

During the Recording mode, the HTML Journal is read-only and cannot be edited. In this mode, the Journal 

provides lesson-specific information to guide you through the calibration and recording. 

 

Journal text in the Recording mode 

The Journal function varies from the Recording mode to the Analysis mode. 

* In the Recording mode, the Journal contains HTML text, images and embedded videos that guide the user 

through the lesson. Use the Recordings preference (page 6) to show all Journal text or show minimal 

Journal text. 

* In the Analysis mode (Review Saved Data), the Journal can be used to write notes and record 

measurements, which can then be copied to another document, saved, or printed. 

NOTE The instructional Journal text is read-only in the standard Biopac Student Lab application. To edit 

onscreen Journal content, you must purchase an activation license for the BSL Curriculum 

Management System. This powerful add-on allows for flexible modification of lesson content and 

allows you to create your own custom lessons. See page 70 for more details on the BSL Curriculum 

Management System, or see Chapter 18 in the BSL PRO Manual. 

 

Save 

As data is recorded, it is saved to the computer’s internal memory. After recording, data is transferred and 

saved to the computer’s hard drive (or wherever the Biopac Student Lab application is running). The program 

will save the data file automatically, with a file name based on the username or I.D. created at the start of each 

lesson. 

The lesson name, file name, date and time will automatically be appended to the Journal when a file is saved 

from the Recording mode. 

 

Closing the Application 

During the recording mode, the application close icon  in the upper right corner of the display window is 

blocked to prevent inadvertently quitting the application while recording. 

If Quit is blocked, click on the STOP button to suspend the recording, and then try Quit again. 
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Help > About Biopac Student Lab 

Select About Biopac Student Lab from the Help menu for information about the software version, hardware 

connections or computer system. (Use Biopac Student Lab menu in Mac OS X) 

Any Lesson Procedure PDF can also be opened from within in the Help menu. 
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Data Analysis 

Data Analysis is performed following the lesson to extract  measurements that reinforce the concepts 

presented in the lesson’s introduction. Analysis can be performed right after the data is recorded, or can be 

done later off-line on another computer. (Hardware does not need to be attached in order to analyze data). The 

analysis should be performed after all students have recorded their data. 

Each lesson involves some degree of analysis, but the Biopac Student Lab software generally handles 

anything more complex than adding two numbers together. The lesson text will walk Subjects through the 

analysis and explain what needs to be done at each step. Refer to the following sections on measurements, as 

necessary. 

The measurements taken in the Analysis section are subsequently placed in the Data Report section and may 

also be copied to the on-screen Journal for saving and printing. Whenever a measurement needs to be placed 

in the Data Report, a reference icon will direct Subjects to the proper section of the Data Report. 

See the following section on “Analysis Mode (Review saved data)” for details on how to access your files 

for Analysis. 

Data Report 

The Data Report is where you note and summarize your data. The Data Report contains questions that 

reinforce the concepts presented in the Introduction. At least a few of the questions are designed to have you 

answer on the particulars of your own data. Whenever practical, the Data Report has reinforced good 

scientific practices like having “control” data and using statistics to look at data from the class. In addition to 

being included at the end of every Lesson Procedure, Data Reports are presented in the Journal while in 

Analysis mode. Journal Data Reports can be freely edited, customized, saved to an alternate location, printed 

or emailed as an attachment. The email as attachment option must be enabled in the BSL preferences file. See 

page 26 for more information about customizing the preference file. 

▪ Journal Data Reports can be easily customized using the Journal toolbar editing tools. 

(Analysis mode only) 

▪ Journals and Data Reports are in BIOPAC’s *.jcq format but can also be exported in 

spreadsheet *.xls,) Journal template (*.jtl,) or OpenDocument (*.odt) formats. To save the 

content to other document formats, select and copy the contents, open the document 

application you wish to use, and paste the contents. 

▪ The “BSL Answer Guide” for Data Reports is included on the Biopac Student Lab 

installation CD but is not installed with the program. See the User Support folder on the CD. 

Modifying the Journal Data Report file: Journal Data Reports are stored in the BSL program folder in a 

special text format called *.jcq format. These files can be modified in an active Lesson’s Review Saved Data 

mode or in the BSL PRO side of the application. The file can be resaved in the same Journal *.jcq format and 

used in place of the default Journal Data Report. To modify the default Journal Data Report content: 

1. Launch the application in BSL PRO mode. (“Create/Record a new experiment” and click OK.) 

2. Go to File > Open and choose “Journal *.jcq” from the file type list. 

3. Navigate to the location of the Lesson Journal file you with to modify (Example: Drive:\Program 

Files\BIOPAC Systems, Inc\Biopac Student Lab 4.1\LessonsSupport\all-lang\Lessons\L01-EMG-

1\html\en\L01 Data Report.jcq) and click “Open.” 

4. The Data Report will open in an editable Journal window. Make the desired edits and save the file 

(File > Save) or File > Save As to save under a different name or directory. 

Note that Journal Data Report files saved under the same name (e.g., “L01 Data Report.jcq) to the default 

directory of the Lesson will overwrite the default Journal Data Report file. For this reason, it’s advisable to 

make a copy of the default Journal Data Report file and keep it in an alternate location in case you’d like to 

restore it at a future date. To restore it, simply copy it back to the default lesson directory and overwrite the 

modified file. 
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Analysis Mode (Review Saved Data) Basics 

Getting into Review Saved Data mode 

You can enter the Review Saved Data mode immediately following the recording or at a later date — even 

from another computer. 

Immediately following the recording 

After clicking “Done” to complete a lesson, choose “Analyze 

current data file” or “Analyze another data file” to enter the 

Review Saved Data mode.  

* Analyze current data file The program will automatically 

open for analysis the file just 

recorded. 

* Analyze another data file The program will display an Open 

dialog for browsing to the desired 

file for analysis. (See “Selecting a 

file for review” on the following 

page.) 

At a later time 

If Biopac Student Lab is running… 

1. Pull down the Lessons menu and select Review 

Saved Data. 

2. Select a lesson file to review (see next section). 

 

Biopac Student Lab Lessons menu 

(Analyze mode) 

If Biopac Student Lab program is not running… 

1. Launch the Biopac Student Lab program. 

If the MP unit is not connected or not turned ON, a message similar to the following will appear: 
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Since the Review Saved Data mode does not require hardware, simply click the “Analyze Only” button. 

2. The Choose a lesson menu shown at right will 

appear. 

3. Scroll down to select Review Saved Data and 

click OK. 

 

NOTE For BSL for MP46/45 hardware, only a 

subset of the lessons is supported. Lessons 

7, 8, 9, 11, 11A, 14, 15 & 20 are not used 

in MP46/45. 

 

 
Choose a lesson prompt 

Selecting a File to Review 

Upon entering “Review Saved Data” 

mode, browse to the desired file and 

click “Open.”  

Note that the lesson number 

extension has been automatically 

added to the file name. 

The BSL application will open the 

lesson file, with the Data Window 

and Journal displayed, as shown on 

the following page. 
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Sample Data File 

There are many sample files 

included with the installation. 

To review a sample file: 

1. Using File > Open, locate 

the Biopac Student Lab 

folder on the drive the 

program was installed to. 

2. Open the Biopac Student 

Lab folder and select the 

Data Files folder. 

3. Open the Data Files folder 

and select the Sample 

Data folder. 

4. Open the Sample Data 

folder and select a file 

(such as Jared-L06). 

 

Screen display after opening a sample file in Review Saved Data mode 
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Software Tools Used for Analysis 

Biopac Student Lab software includes a variety of Display Tools for modifying the data display by adjusting 

axis scales, hiding channels, zooming in, adding grids, etc. This can be very useful when studying just a 

portion of a record, or to help identify and isolate significant data for reporting and/or analysis. 

Basic descriptions of the standard tools follow; for further explanation, see “Beyond Basics” on page 49. 

 

Basic Display Tools for Analysis 

Viewing Tool Overview 

 

Selection 

The selection (arrow) icon is a general-purpose cursor, used for selecting channels and 

scrolling through data.  

 

I-Beam  

The I-beam icon is used to select an area for measurement. To activate it, click it and 

move the mouse such that the cursor is positioned at the beginning of the region to be 

selected. The cursor must be positioned within the data window. Hold the mouse button 

down and move (drag) the cursor to the second position. Release the mouse button to 

complete the selection. The selected area will remain darkened. Measurements will apply 

to the selected area. For more details on selecting an area for measurement, see page 55. 

 

Zoom  

The zoom icon magnifies selected areas of data. Click the zoom icon and define an area 

of interest by click-hold-drag-releasing the mouse over the desired section. The 

horizontal (time) and vertical (amplitude) scales will expand to display just the selected 

section. For more details about the Zoom tool, see page 50. 

 

Annotation 

The annotation tool allows text to be added into any channel within the display window. 

Clicking a graph channel when this tool is active brings a field for entering text, along 

with font and formatting options. The text box can be repositioned as desired by 

selecting and dragging to the desired location. Existing text can be edited by double-

clicking on the text box, which reopens the annotation dialog. 
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Show/Hide Channels 

Another display feature of the Biopac Student Lab system is the ability to hide channels from view. The data 

is not lost, but simply hidden, so that the user can focus on a specific channel or channels. Hidden channels 

can be brought back into view at any time. 

To hide a channel, click on the desired channel button   while holding down the Alt (Option) key. 

The hidden channel’s button will contain a slash. To toggle the channel back into view (unhide), simply 

repeat the Alt click.  

 

Hide channels (Channel 2 and Channel 40 are hidden) 

Grids 

  

A grid is a series of horizontal and vertical lines that assist the eye with finding data positions with respect to 

the horizontal and vertical scales. Grids can be fixed or variable. A fixed grid has grid lines locked to the 

data. When fixed grids are on, the horizontal and vertical scale adjustments are locked out, but the user may 

still use the zoom options. In general, any lesson that records an ECG signal will use fixed grids, but there are 

exceptions to this. 

Grids will appear in the recording mode of selected lessons, to assist the user in obtaining certain values (like 

the grip strengths required in Lesson 2 EMG II). Grids will only be displayed in the recording mode when 

they are absolutely needed, so that the waveform can be more clearly displayed. 

IN BSL LESSONS: To show or hide the grid 

display in the Review Saved Data mode: 

1. Open a data file. 

2. Use the Show Grid Hide Grid buttons at the top 

of the display. 

 

 

 

IN BSL PRO: Choose Display > Show and 

check/uncheck the Grid option. 
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Overlap and Split buttons 

The software defaults to a Split display, which functions like a chart recorder and keeps each waveform in a 

separate track. If an Overlap button is available, you can select it to switch to an oscilloscope style display 

that overlaps multiple waveforms in one track. 

Measurement Tools 

Extracting information from the data 

Measurement tools are used to extract specific information from the waveform(s). Measurements are used in 

the Data Analysis section of every lesson, so understanding their basic operation is important.  

 

Measurement Tools for Analysis 

Two important points regarding measurements: 

1. The measurement only applies to data in the selected area of the waveform that the user specifies. 

2. Every lesson contains the same measurement options, but some may not be applicable to that particular 

lesson. This is because the measurement options are a standard set of tools that are always available, 

much like a scientific calculator contains a standard set of buttons, many of which may not be necessary 

for any given problem. Although the lessons will specify which measurements to use, the student may 

want to familiarize themselves with all the measurements, so they can explore the data beyond what the 

lesson requires.  

For example, to extract the heart rate for the data shown below: 

By counting the peaks (R-Waves) in the ECG waveform, it’s possible to get a rough estimate of the average 

heart rate. Count the number of peaks within the first 10 seconds (9 in this example) and multiply by 6 to get 

the number of beats per minute (54 in this example). 

 

Sample ECG Data 
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An easier and more accurate way to obtain a Subject’s precise heart rate is with the Biopac Student Lab 

measurement tools. In the figure below, the BPM is 55.76 for the selected beat-to-beat interval. 

 

BPM Measurement for one beat-to-beat interval 

Saving 

As data is recorded, it is saved to the computer’s internal memory. After recording, data is transferred and 

saved to an assigned location. The program automatically saves the data file, with a file name based on the 

username or I.D. given at the start of each lesson. 

• BIOPAC recommends the original save location is on a local hard drive to minimize possible data 

loss due to network communication issues.  

If students want to duplicate the data file when the lesson is finished, before they begin analysis, the “Copy to 

another location” option allows them to save a copy of the lesson data to the selected location (such as a 

centralized data folder on a school network). 

 

Printing 

The Biopac Student Lab software has powerful printing capabilities and will print graphs and journals to any 

inkjet or laser printer. Control the amount of data that is printed by adjusting the screen display before 

selecting Print from the File menu. Use the Journal Toolbar controls to modify the format of text, wave 

data, and/or measurements in the Journal before printing.  

 
 

(The Journal is printed from the Print  icon on the Journal toolbar). 
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Analysis: Beyond Basics 
At this point, you are encouraged to follow the Tutorial documentation. If that is not available, open up the 

sample data file and follow along on the computer if possible. To access the sample data file, follow the 

procedure outlined in the “Getting into the Review Saved Data mode” section on page 42.  Open the “Sample 

Lesson Data” folder to select “Gail-L02”. Have fun experimenting and don’t worry — you can’t lose or 

damage the Sample Data file. 

Changing the Scales 

Horizontal Scale 

Clicking within the numbers of the horizontal scale 

(x-axis) region of the graph generates the dialog 

shown to the right. 

Adjust the settings in this window to precisely 

specify the horizontal scale for all channels. For a 

detailed explanation of the vertical scale settings, 

see the BSL Tutorial or BSL PRO Manual. 

Note that any change you make to the Horizontal 

Scale only affects the waveform display and never 

alters the saved data. 

 

 

 

Horizontal Scale Adjustment 

Vertical Scale 

Clicking the vertical scale (y-axis) region of the 

graph generates a dialog for modifying the upper 

and lower ranges of the selected channel. For a 

detailed explanation of the vertical scale settings, 

see the BSL Tutorial or BSL PRO Manual. 

Note that any change made to the vertical scale 

only affects the waveform display and never alters 

the saved data. 

 

 

 

Vertical Scale Adjustment 
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Zoom 

The zoom tool is very useful for expanding a specific section of a waveform in order to see more detail. 

To use the zoom tool: 

1. Click on the zoom tool icon  to select it. 

2. Draw a box around the area you wish to zoom in on. 

 * To draw the box, hold the mouse button and drag the cursor to the end of the desired region. 

 

Zoom tool used to select a portion of ECG data 

3. Release the mouse button. 

When the mouse button is released, the boundaries of the selected area become the new boundaries of the 

Data Window, as shown in the following figure. 

 

Result of using the zoom tool to select an area 

Note that the vertical scale changes for the selected channel only, but the horizontal scale changes for all 

channels. This is because the horizontal (time) scale is the same for all channels.  

How to undo the Zoom 

To revert to the (horizontal and vertical) scale settings used prior to the last Zoom, click the Display menu, 

and scroll to select Zoom Backward. Note that you can “undo” up to five Zoom aspects. 
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Display Menu 

The Display Menu contains even more tools for manipulating the data display. When you click Display and 

hold down the mouse, the menu options will be generated. To use any of these options, drag down to the 

desired selection, then release the mouse button. 

   

Autoscale Waveforms 

Autoscale Waveforms performs a “best fit” to each channel’s vertical scale. That is, it adjusts the “Scale” 

and “Midpoint” of each channel’s vertical scale, such that each waveform fills approximately two-thirds of its 

available track area. 

     

Before Autoscale waveforms    After Autoscale waveforms 

Autoscale Horizontal 

Autoscale Horizontal fits the entire waveform (all the data you have collected) within the data window. That 

is, it will adjust the horizontal scale such that the left-most portion of the screen is the start of the recording, 

and the right-most portion is the end of the recording. 

    

Before Autoscale horizontal  After Autoscale horizontal 

TIPS The “Scale” or “Time-per-Division” setting will probably not be set to even numbers after an 

Autoscale function, so you may need to manually adjust the setting if even numbers are required. 

 One way to ensure the complete data file is displayed on the screen is to select Show All Data. This 

is very handy if you have lost track of where you are in the data due to manual scale changes, 

zooming, etc. 
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Event Markers 

Event Markers are inverted triangles that are placed within the marker region at specific points to mark areas 

of interest or indicate the start of a new recording segment. Some lessons insert event markers automatically 

during the recording, and others require that event markers be entered manually. To insert an event marker, 

depress the F9 key. You may then type in text linked to that marker, but which will be displayed in the left 

portion of the marker region.  

The “active” marker appears darkened, and the marker text corresponds to the active marker  

 

Event Marker elements 

Event Marker Tools 

You may change the active marker by using the “event marker tools” in the right portion of the marker 

region. 

*  Click the left pointing event marker tool to move to the event marker that was placed prior to the 

current active marker (if one exists). 

* Click the right pointing event marker tool to move to the event  marker that was placed after the current 

active marker (if one exists). 

* Right click any event marker to generate a pop-up menu, as shown here: 

 

Clicking ‘Edit Event’ will open the Event Palette, which allows for editing, labeling or removal of Event 

Markers. 

Event Palette 

The Event Palette is a floating window that provides a quick summary of events for the topmost graph and 

can used to examine, search, and modify events. Events can be extracted in a time range for a specific event 

type and specific channels. 

There is only one visible event palette for the entire application. The palette consists of four sections: event 

list, selected event, display, and event actions. Each section can be shown or hidden by toggling the disclosure 

button next to its title. 



Basics 53 

 Biopac Student Lab 

 

Event Palette 

To choose an event marker menu item, simply scroll to the desired item in the event list and highlight it. The 

event Actions allows you to Find events, Find next event, Clear the active marker, Clear all events, 

Summarize in Journal, (inserts list of Event Markers into Journal), or mark Selection (places event markers at 

beginning and end of selected area).  

Add or Edit Event Markers 

You may add event markers to your data after it has been recorded by clicking within the event marker region 

with the Selection tool. The new marker will become the active marker, and you may type in the marker text. 

All event marker text is editable. Just position the cursor in the marker label region and make the desired 

changes.  

 

Event Marker Label Region 

Printing Event Markers 

When you print out the waveform(s) the marker text will appear above the appropriate marker, and a dashed 

vertical line will appear through the data to indicate the marker’s precise point in time. If the data is 

compressed, the markers and/or marker text may overlap and/or be hidden. Adjust the time scale to expand 

the marker display as necessary before selecting print. 

 

Lesson Specific Display Buttons 

Depending on the data you are viewing, lesson specific display buttons may appear when you are in the 

Review Saved Data mode. These include the Overlap, Split and Baseline buttons, discussed below. If other, 

more specialized buttons appear, their operation will be discussed in the lesson. 
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Overlap and Split 

The “Overlap” and “Split” buttons allow you to toggle between an oscilloscope style display and a chart 

recorder style display. Simply click on the desired button to activate the display style you desire. 

Overlap 

The oscilloscope style interface allows the waveforms to “overlap” each other. This can be very useful when 

comparing different waveforms from one channel to each other.  

 

Overlap waveforms 

Note that by alternating the active channel selection and using the vertical scroll bar, you can move each 

waveform with respect to the other(s) for precise alignment. If grids are shown, the display be based on the 

active channel. 

In the preceding figure, Channel 1 ECG is the active channel (channel box appears depressed and channel 

label is ECG) and vertical scale adjustments would only move the ECG waveform. To move the Pulse 

waveform, it’s necessary to activate Channel 40 Pulse prior to adjusting the vertical scale. 

Split 

The Split (chart recorder) display divides each channel’s waveform to its own region. This is the default 

display mode for Biopac Student Lab. Only one channel can be active at a time. Adjusting the vertical scale or 

scrolling the vertical axis up or down affects only the active channel. 

 

Split waveforms 
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Adjust Baseline 

Appears in “Lesson 5 ECG I” only 

The Adjust Baseline button allows the waveform to be positioned up or down in small increments so that the 

baseline can be exactly zero. This is not necessary for obtaining accurate amplitude measurements, but may 

be desired before making a printout or when using grids. 

  

Adjust Baseline button displays Up/Down buttons 

After the Adjust Baseline button is pressed, Up and Down buttons will be displayed. Simply click on these to 

move the waveform up or down. 

The Exit button will close the Adjust baseline options and return to the waveform display. 

Selecting an Area for Measurement 

The “selected area” for all measurements is the area selected by the I-Beam tool (including the endpoints). 

Note that the “I-beam” cursor position when the mouse button was first pressed defines the starting point and 

the position at release defines the endpoint of the selected are, inclusive. 

A critical concept for the measurement tools is that measurement results only apply to the area established by 

the “I-Beam” cursor. The measurement area can be a single point, an area, or the endpoints of a selected area. 

If no data point or area is highlighted on the screen, then the measurement results are meaningless. It is up to 

the student to select a point or an area with the I-Beam cursor, as the software will never do it automatically.  

Selecting a single point 

To select a single point: 

1. Click on the I-Beam tool icon to activate it. 

2. Move the cursor over a point on the data. Notice that whenever the cursor is over data it is displayed as an 

“I.” 

3. Release the mouse button. 

When you have selected one point of data, a flashing line will appear at the cursor position, as shown in the 

figure below. If the line is not flashing, it means that you moved the cursor while the mouse button was 

pressed, and you actually selected more than one point of data. If this occurred, simply click on another 

portion of data. 

 

Single point measurement area 

To deactivate a point when you are finished taking measurements, click on the Selection tool icon. 



56 Biopac Student Lab 

 Biopac Student Lab 

Selecting an Area with the I-Beam Tool 

To select an area of data (several data points, including the endpoints): 

1. Click on the I-Beam tool icon to activate it. 

2. Move the cursor over a point on the data. You will notice that whenever the cursor is over data it is 

displayed as an “I.” 

3. Drag the mouse while keeping the mouse button held down. 

4. Release the mouse button. 

When the mouse button is released, an area should be highlighted (darkened) on the screen, as shown in the 

figure below. This is very similar to how you select words in a word processing program. 

 

Selecting an area 

When you are finished taking measurements and wish to deactivate a selected area, click another portion of 

data to select just one point (flashing line appears), then click the Selection tool icon to deactivate the point. 

Note: Since some measurement formulas (such as delta) use the start value and end value, the direction you 

“drag” to create the selected area will influence the polarity of some measurements. 

 

Channel Measurement Box Regions 

 

 

Elements of the Measurement Tool Region 

Note that there are two channel measurement box regions shown in the above example. The channel 

measurement boxes can be set to correspond to any of the channels displayed on the screen. The preceding 

figure shows two channels of data displayed in the data window. 

The number of channels displayed will vary, with up to eight different channels of data displayed on the 

screen at once (software-controlled, depending on the lesson). You may set more than one channel 

measurement box to the same channel. For instance, you may want to measure BPM and Time for Channel 1, 

so you would set two boxes to Channel 1. 



Basics 57 

 Biopac Student Lab 

Channel number 

[CH] Pop-up 

menu 

The channel number pop-up menu lets you set the channel number to apply the 

selected measurement to. 

To set a channel number, click and hold down the mouse button over the channel 

number box. A pop-up menu will appear allowing you to make a selection. The 

selections in the pop-up menu will contain the channels that were recorded (“1” and 

“40” in the figure above) plus the “SC” option. 

To “fix” the channel number for the region, choose the desired channel number. 

To determine which channel number refers to which waveform, look to the right of the 

box(es) for the active channel box label. To change to another channel, simply click its 

channel box, and note the new label. 

SC - Selected 

Channel 

“SC” stands for Selected Channel, and is an optional way to take measurements. 

When SC is selected, the channel the measurement region refers to is the one indicated 

by the depressed channel number box (below the channel measurement box region). 

The “SC” option allows for quick measurement comparisons between channels using 

one region. To take a measurement from another channel, simply click the desired 

channel box or click anywhere within the desired channel’s data region using the 

selection tool. 

Measurement type 

Pop-up menu 

 

The measurement type box is a pop-up menu that allows you to choose any of the 34 

Biopac Student Lab measurement functions, which are defined in the following Table 

of Measurement Definitions. Each measurement functions on a single point, an area, 

or the end points of a selected area, as established by the “I-Beam” tool. To remove a 

channel from displaying any measurement type, choose “None” from the popup menu. 

Measurement 

Result 

The measurement result is the value that the measurement calculates. 

If the correct region is not established for the measurement type, the result will be 

meaningless. See the Table of Measurements by Selected Area (on the next page) for a 

summary of tools for each region. 

The measurement units will not be shown — you must keep track of the units from the 

display window scale regions. 

The result will read “****” if there is no data selected or not enough data for the 

selected measurement. 



58 Biopac Student Lab 

 Biopac Student Lab 

Available Measurements for Analysis 

 
Elements of the channel measurement box region 

For measurement definitions and descriptions, please see your BSL Tutorial or BSL PRO Manual. 
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Data Window (Edit menu option) 

 

The Edit menu Data Window option includes three copy options that are to be used for measurements and 

waveforms in the Data Window (versus the Journal). The distinctions of each are detailed below. 

 

Edit > Data Window option Use 

Copy measurement 

 

Use to copy the measurement values from the data window. 

Copy wave data 

 

Use when you want to copy waveform data as a set of numbers. The 

data copied will include all wave data within the area selected by the 

 I-beam cursor. 

Copy graph Use when you want to copy the waveform data as a picture to be 

imported into other programs. 

The Data Window Copy functions will be applied to the selected area, 

if any. If a single point or no area is selected, the Data Window Copy 

functions will be applied to the entire data file. 

Copy Event Summary Copies a summary of graph events to the clipboard, including 

event type, position on horizontal axis, channel and label 

information. 

The Journal 

In the Review Saved Data mode, the Journal feature is editable, so you can type notes or copy measurements 

from previously saved data. You can also copy data directly to the Journal. When in the Review Saved Data 

mode, click anywhere in the Journal window to activate it. 

 

Journal Window 

Format Journal Entries 

Change the style and format of text, measurements, and waveform data pasted to the Journal by 

using the formatting tools above the Journal window. (Available in Lessons in Analysis mode only.) 

  



60 Biopac Student Lab 

 Biopac Student Lab 

Journal Paste Options (Edit menu) 

 

Paste a pop-up measurement 

 

BPM and P-P measurements for Channel 1 pasted to Journal 

When you use the Paste Measurement function, all the pop-up measurements showing a value will be written 

to the Journal. If you don’t want these measurements, be sure to select the measurement option “None.” 

To paste a pop-up measurement into the Journal: 

1. Select the channel you want to measure by clicking on it with the Selection tool or use the cursor to pick 

the correct channel number in the boxes just left of each of the pop-up measurements. 

2. Choose the appropriate pop-up measurement. 

3. Use the I-beam tool to select the portion of the wave you are interested in. 

The pop-up measurement values will update instantly. The pop-up measurements always operate on the 

selected area you have chosen with the I-beam tool. For instance, if you choose p-p, you will find the 

peak to peak value of the wave in the selected area. If you choose max, you will get the maximum value 

of the wave in the selected area. 

4. Pull down the Edit menu and select Journal > Paste Measurement. Alternatively, you can use the Ctrl-M 

keyboard shortcut. 

 

Paste wave data 

 

Wave data for Channel 1, Channel 2 and Channel 40 pasted to Journal 

When you use the Paste Wave Data function, all the points that make up the data in the selected wave area 

will be written to the Journal. It’s very easy to put a lot of data into the Journal using this command. If you 

select one second of a wave that was sampled at 200 Hz, you will get 200 numbers written into the Journal. 

To paste wave data into the Journal: 
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1. Select the channel you wish to measure by clicking on it using the Selection tool or use the cursor to pick 

the correct channel in the channel boxes just left of each of the pop-up measurements. This will activate 

the Data Window. 

2. Use the I-beam tool to select the portion of the wave you are interested in. 

3. Pull down the Edit menu and scroll down to Journal then scroll right to Paste Wave Data. Alternatively, 

you can use the Ctrl-W keyboard shortcut. 

Remember — it’s very easy to paste a lot of numbers to the Journal. Pasting just one second of a wave that 

was sampled at 1000 Hz will write 1000 numbers into the Journal. 

Paste Graph 

Use this option to paste a screenshot of the current graph into the Journal. 

Paste Event Summary 

Pastes a summary of graph events to the Journal, including event type, position on horizontal axis, 

channel and label information. 

Time and Date Stamps in the Journal 

The Journal is equipped with stamps for the time and date.  

It’s always a good idea to time and date stamp the Journal. The time stamp is the “clock” button at the top left 

of the Journal window. The date stamp is the “calendar” button to the right of the time stamp. 

Journal Text entry 

It’s possible to write anything you want directly in the Journal. Just click on the Journal window and place the 

cursor at the point you wish to begin typing. To return to the graph, click in the graph window. 

Use the Edit > Copy option to copy Journal text to another program or to another section of the Journal. 

Use the formatting tools in the Journal toolbar to customize the text style. 

 

Journal tables can be added formatted 

and deleted using the table icons on 

the right side of the Journal toolbar. 
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Adding a hyperlink to the Journal 

 

Add a live web link to the Journal 

using the hyperlink toolbar icon.  

Click into the Journal where you want 

the link to appear. 

Enter the URL (web address) and the 

desired link name into the Text field.  

Note: The http:// designation must be 

used for the link to be active. 

Saving the Journal 

To save a Journal, click the   icon on the Journal toolbar. This will display a File >Save option for 

saving the Journal under a unique name to a *.jcq format 

Lesson Save Options 

In Recording Mode 

When the  button is pressed, data is automatically saved to the location assigned at startup.   

The lesson Done dialog option "Copy to another location" allows students to create a copy of the 

currently opened file. To set the default location, use the lesson startup file (see Menu Customization on 

page 26). 

Select the desired directory and drive and click OK to copy the lesson file(s). The “File name” entry is 

locked because the original name must be preserved when a file is copied. 

 

    
 

In Review Saved Data Mode 

There are two ways to save a file after analysis in the Review Saved Data mode: 

• Save Changes will ensure that the files are properly named and saved to 

the location the file was opened from. 

• Save As allows students to save data to a different location. 
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Experimental Objectives by Lesson 

Lesson 1 EMG I 

▪ To observe and record skeletal muscle tonus as reflected by a basal level of electrical activity 

associated with the muscle in a resting state. 

▪ To record maximum clench strength for right and left hands. 

▪ To observe, record, and correlate motor unit recruitment with increased power of skeletal 

muscle contraction. 

▪ To listen to EMG “sounds” and correlate sound intensity with motor unit recruitment. 

Lesson 2 EMG II 

▪ To determine the maximum clench strength for right and left hands and compare differences 

between male and female. 

▪ To observe, record, and correlate motor unit recruitment with increased power of skeletal 

muscle contraction. 

▪ To record the force produced by clench muscles, EMG, and integrated EMG when inducing 

fatigue. 

Lesson 3 EEG I 

▪ To record an EEG from an awake, resting subject with eyes open and eyes closed. 

▪ To identify and examine alpha, beta, delta, and theta components of the EEG complex. 

Lesson 4 EEG II 

▪ To record an EEG from an awake, resting subject under the following conditions: 

o Relaxed with eyes closed. 

o Performing mental arithmetic with eyes closed. 

o Hyperventilating (breathing quickly and deeply) with eyes closed. 

o Relaxed with eyes open. 

▪ To examine differences in the level of alpha rhythm activity during mental arithmetic and 

hyperventilation, compared to the control condition of eyes closed and relaxed. 

Lesson 5 ECG I 

▪ To become familiar with the electrocardiograph as a primary tool for evaluating electrical 

events within the heart. 

▪ To correlate electrical events as displayed on the ECG with the mechanical events that occur 

during the cardiac cycle. 

▪ To observe rate and rhythm changes in the ECG associated with body position and breathing. 

Lesson 6 ECG II 

▪ Record ECG from Leads I and III in the following conditions: supine, seated, and breathing 

deeply while seated. 

▪ Compare the displayed calculated ECG Lead II to recorded ECG Leads I and III, and use the 

R wave amplitudes to confirm Einthoven’s Law. 

▪ Approximate the mean electrical axis of the ventricles on the frontal plane using vectors 

derived from the amplitude and polarity of the QRS complex in ECG Leads I and III. 

▪ Approximate the mean electrical potential of the ventricles on the frontal plane using the 

resultant vector derived from the vectors of Leads I and III. 
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Lesson 7 ECG & Pulse 

▪ To become familiar with the principle of plethysmography and its usefulness in qualitatively 

assessing peripheral changes in blood volume. 

▪ To observe and record changes in peripheral blood volume and pressure pulse under a variety 

of both experimental and physiological conditions. 

▪ To determine the approximate speed of the pressure pulse wave travelling between the heart 

and the finger. 

▪ To illustrate the electrical activity associated with normal cardiac activity and how it relates 

to the flow of blood throughout the body. 

Lesson 8 Respiratory I 

▪ To record and measure ventilation utilizing pneumograph and air temperature transducers. 

▪ To show how ventilation relates to temperature changes in airflow through one nostril. 

▪ To observe and record chest expansion and contraction and modifications in the rate and 

depth of the breathing cycle due to cerebral influence and chemoreceptor influence on the 

medullary control centers. 

Lesson 9 EDA & Polygraph 

▪ To become familiar with procedures for recording electrodermal activity. 

▪ To observe and record changes in respiratory rate, heart rate, and skin resistance associated 

with somatic and special sensory stimuli. 

▪ To observe and record changes in respiratory rate, heart rate, and skin resistance associated 

with cognitive behavior and emotion. 

▪ To analyze a 3-channel polygram recorded under various experimental conditions to gain a 

better understanding of polygraphy and its potential for use and misuse. 

Lesson 10 EOG I 

▪ Record EOG and compare eye movements during real and simulated tracking of a pendulum. 

▪ Record EOG and compare eye movements during real and during simulated tracking of an 

object in the vertical plane. 

▪ Record and compare the “saccadic” eye movements when reading three different ways; 

silently (easy), silently (challenging) and aloud (challenging). 

Lesson 11 Reaction Time I (Auditory Reaction Time) 

▪ Observe the effect of learning and the effect of anticipating the stimulus delivery on reaction 

time. 

▪ Compare reaction times in four stimulus-response situations: 

a) Fixed interval stimulus presentation using the dominant hand for the response. 

b) Random interval stimulus presentation using the dominant hand for the response. 

c) Fixed interval stimulus presentation using the nondominant hand for the response. 

d) Random interval stimulus presentation using the nondominant hand for the response. 

▪ Compare the reaction times for groups of subjects by calculating the statistics of group mean, 

variance, and standard deviation in each of the four stimulus-response situations. 
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Lesson 11A Reaction Time II (Visual Reaction Time) 

▪ Observe the effects of learning and anticipation of the stimulus delivery on reaction time. 

▪ Compare reaction times in four stimulus-response situations: 

e) Fixed interval stimulus presentation using the dominant hand for the response. 

f) Random interval stimulus presentation using the dominant hand for the response. 

g) Fixed interval stimulus presentation using the nondominant hand for the response. 

h) Random interval stimulus presentation using the nondominant hand for the response. 

▪ Compare the reaction times for groups of subjects by calculating the statistics of group mean, 

variance, and standard deviation in each of the four stimulus-response situations. 

▪ Compare the visual stimulus reaction times to the auditory stimulus reaction times obtained in 

Lesson 11 (Reaction Time I). 

Lesson 12 Pulmonary Function I 

▪ To observe, record and/or calculate selected pulmonary volumes and capacities. 

▪ To compare the observed values of volume and capacity with average values. 

▪ To compare the normal values of pulmonary volumes and capacities of subjects differing in 

sex, age, weight, and height. 

Lesson 13 Pulmonary Function II 

▪ To observe experimentally, record, and/or calculate forced expiratory volume (FEV) and 

maximal voluntary ventilation (MVV). 

▪ To compare observed values of FEV with predicted normals. 

▪ To compare MVV values with others in your class. 

Lesson 14 Biofeedback 

▪ To introduce the concept of biofeedback training for relaxation. 

▪ To measure levels of arousal via heart rate and electrodermal activity (EDA). 

Lesson 15 Aerobic Exercise Physiology I 

▪ Record and compare changes in pulmonary airflow before, during, and after a brief period of 

moderate exercise. 

▪ Record and compare changes in respiratory rate and changes in heart rate before, during, and 

after the exercise period. 

▪ Compare and note any changes in Lead II electrocardiogram recorded before, during, and 

after moderate exercise. 

▪ Record and compare changes in skin temperature associated with the brief periods of 

moderate exercise and recovery. 

Lesson 16 Blood Pressure 

▪ To use an auscultatory method for an indirect determination of systemic arterial systolic and 

diastolic blood pressures and — To correlate the appearance and disappearance of vascular 

sound with systolic and diastolic pressures respectively. 

▪ To measure, record, and compare systemic arterial blood pressure in the right arm and the left 

arm of the same Subject under identical conditions. 

▪ To measure, record, and compare systemic arterial blood pressures in the same Subject under 

different experimental conditions of rest and exercise. 

▪ To compute and compare pulse pressure and mean arterial pressure under different 

experimental conditions of rest and exercise. 

▪ To compute the pulse pressure wave velocity by measuring the time between the R-wave of 

the ECG and the Korotkoff sounds. 
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Lesson 17 Heart Sounds 

▪ To listen to human heart sounds and describe them qualitatively in terms of intensity or 

loudness, pitch, and duration. 

▪ To correlate the human heart sounds with the opening and closing of cardiac valves during 

the cardiac cycle and with systole and diastole of the ventricles. 

▪ To determine the nature of the change in the relationship between electrical and mechanical 

events of the cardiac cycle as heart rate increases. 

Lesson 20 Spinal Cord Reflexes 

▪ To become familiar with anatomical and physiological elements of simple spinal reflexes. 

▪ To examine properties of some simple neuromuscular reflexes commonly tested in physical 

diagnosis. 

▪ To measure and compare latent periods and reaction times of extensor and flexor reflexes. 

▪ To elicit an extensor reflex and compare contractile force vs. stimulus strength. 

▪ To apply the Jendrassik maneuver and observe exaggeration of an extensor reflex. 

▪ To measure and compare reaction times of voluntary activation of skeletal muscle vs. 

involuntary (reflex) activation of skeletal muscle. 
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Biopac Student Lab PRO Features 

For advanced studies and customized lessons, use the Biopac Student Lab PRO. This powerful software 

option is included with the Biopac Student Lab, and detailed information is available in the digital PRO 

Manual under the BSL PRO Help menu or in the installed User Support folder. 

Biopac Student Lab PRO (BSL PRO is installed with the Biopac Student Lab) 

Easy to use The Biopac Student Lab PRO offers the same convenient and easy-to-use 

features that Windows® users are accustomed to. Since the Biopac Student Lab 

PRO software runs under these environments, you can run other applications 

while you are collecting data. In terms of hardware setup the Biopac Student Lab 

PRO uses simple plug-in connectors and standard interface cables. You don’t 

need a degree in electronics to set up your system. 

Flexible setup The Biopac Student Lab PRO can be configured for a wide variety of 

applications, from single channel applications to multiple-device (up to 4 analog) 

measurements. Control the length of acquisition, the rate at which data is 

collected, how data is stored, and more.  

Flexible acquisition 

rates 

The Biopac Student Lab PRO can acquire data from 1 to 100,000 samples/sec. 

This allows recording of almost all physiological parameters from slow moving 

temperature data to fast response action potential data.  

Flexible menu 

display 

Easily customize menu displays to show only the functions you are using, 

thereby reducing the risk of error or confusion in the lab. This is particularly 

powerful for laboratories working to GLP guidelines and is also useful for 

teaching applications.  

On-line calculations Although the Biopac Student Lab PRO software provides an extensive array of 

measurements and transformations you can apply to collected data, sometimes 

you need to perform computations while data is being collected. The On-line 

Calculation functions allow you to calculate new channels based on incoming 

signals. This feature allows you to compute BPM, for instance, based on raw 

ECG data. 

On-line filtering Many times, it is preferable to filter data as it is being collected, rather than 

having to wait until after the fact, so now you can apply filters to incoming data 

and view the results in real time. That means on-line monitoring of data filtered 

to suit your needs. 

On-line 

measurements 

The Biopac Student Lab PRO software can instantly compute over a twenty 

measurements and computations for any given data point(s). These options are 

available from pull-down menus and include mean; peak-to-peak value; standard 

deviation; frequency; and BPM. 

Grid options You can apply several different grid styles to your data to help with analysis. 

UNLOCKED grids help you view the data display on the monitor whereas 

LOCKED grids help more with printing. You can set the Grid Options to create 

printouts that look similar to chart recorder output. Add minor grid lines if 

desired, and select the line width, color, and style for all grid lines. 

Presets There are over 80 factory-established “Presets” that allow the user to easily 

configure hardware parameters. These presets can be modified, and/or new 

presets can be created and saved for later use.  
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Graph templates This powerful feature allows instructors to predefine experiments. Students 

simply open the template file and click “Start” to run the experiment. A sample 

graph template file (HeartTemplate.gtl) is included with the PRO installation. 

Preview your data Biopac Student Lab PRO allows you to change both the vertical scale and the 

horizontal scale. You can change the amplitude scale or the time scale to any 

value you wish, or you can have the Biopac Student Lab PRO software 

automatically scale them for you. 

Simplified editing Delete unimportant sections of your data with a keystroke. You can “paste” 

together sections from different waves, or edit out noise spikes from individual 

waves. 

Append mode For some applications, data only needs to be recorded during some portions of a 

long experiment. The Biopac Student Lab PRO software has an Append mode 

that lets you pause the acquisition for as long as you wish, and resume the 

acquisition as many times as needed. When data are acquired in this mode, you 

can start and stop a recording as you would with a chart recorder. This saves on 

storage space and processing time for transformations. 

Digital filtering All data contains measurement error and noise. Now you can reduce or eliminate 

that error by using the digital filters and smoothing transformations included in 

the Biopac Student Lab PRO software. You can smooth data or filter out noise 

from any frequency or bandwidth you wish. 

X/Y plotting You can view and acquire data in the form of an X/Y plot, with one channel on 

the horizontal axis and another on the vertical axis. This allows you to explore 

relationships between different channels and opens up a whole range of 

applications, from chaos plots to respiration analysis to vectorcardiograms. 

Histogram function You can easily examine the variability and the measures of central tendency of 

any waveform data with the histogram function. Set the plotting options to suit or 

let the software determine the “best fit” for graphing data. 

Math functions In many cases, simply collecting raw data is not enough. The BSL PRO software 

has an array of built-in mathematical functions ranging from simple absolute 

value functions to computation of integrals, derivatives, and operations involving 

multiple waveforms (such as subtracting one wave from another). You can even 

chain multiple functions together to form complex equations. 

Media Capture Connect a USB camera and capture audio/video of a subject during acquisition. 

This captured media can be viewed during acquisition and playback of the linked 

data file. (BSL 3.7.7 and later only) 

Triggering If you need to measure response times or start data collection only after some 

event has occurred, the Biopac Student Lab PRO software allows you to trigger 

an acquisition in a number of different ways. You can trigger on the level of a 

signal, or with an external synchronizing trigger. 

Event markers  Many times, especially during a long acquisition or in a laboratory setting, it is 

useful to make a note of when specific events (such as manipulation) occur, so 

that any changes in the data can be noted. The marker function allows you to 

insert symbols in the record and add up to 80 characters of text for each marker. 

Markers can be added either while data is being collected or after the fact. 



How It Works 69 

 Biopac Student Lab 

 

File compatibility With the Biopac Student Lab PRO software, you can save data in a number of 

different formats. You can output data in either text or graphical form, and export 

or use the clipboard to place data in other programs. Use BSL PRO data in word 

processing programs like Microsoft Word®, spreadsheet programs like 

Microsoft Excel®, drawing programs like Aldus IntelliDraw®, or desktop 

publishing programs like Aldus PageMaker®. Biopac Student Lab PRO software 

will even read-in raw data from a text file. 

Pattern recognition Using an advanced pattern search/recognition algorithm, the Biopac Student Lab 

PRO software can automatically find a specific pattern within waveforms. This is 

useful for finding abnormal waveforms (such as irregular ECG waves) within a 

data file. 

Peak detection The Biopac Student Lab PRO software has a built in algorithm to find either 

positive or negative peaks from any size data file. You can even search for all the 

peaks with one command and automatically log statistics like peak time and area 

to the journal. 

Printing options The Biopac Student Lab PRO software provides a range of printing options, and 

allows you to fit data on one page or many. You can also print several graphs per 

page, even if you only have one-channel recordings.  

Sample data files The Biopac Studetnt Lab PRO installation disk includes sample data files from: a 

4-channel recording, Blood Pressure, EEG, EMG with Force, Finger Twitch, and 

more. 

User support Whether you have a question about compatibility with existing equipment or 

need to develop a specialized measurement device, BIOPAC’s Applications 

Department can address the problem. Plus, you can visit the BIOPAC website at 

www.biopac.com for answers to frequently asked questions, product 

information, and a wide array of Application Notes. 

 

http://www.biopac/
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BSL Curriculum Management System 

 
The BSL Curriculum Management System is 

available through optional licensing in BSL 4.1 and 

above only. The license must be authorized to use 

this lesson customization tool. To add a license to an 

existing Biopac Student Lab installation, please 

contact BIOPAC. 

Overview 

The BSL Curriculum Management System is a 

licensed feature that allows instructors to substitute 

customized lesson content and create user-defined 

onscreen lesson instructions for any existing BSL 

Lesson. It also has a built-in networking feature 

allowing instructors to easily broadcast customized 

content to student workstations over a local network. 

The level of control over lesson customization in the 

BSL Curriculum Management System goes well 

beyond the scope of standard BSL Lessons & PRO 

and is ideal for instructors wishing to create, edit, and 

modify content in a seamless, flexible fashion.  

Use the BSL Curriculum Management System to: 

▪ Associate custom recording procedures, 

analysis procedures, introductions and data 

reports with any existing BSL Lesson with a 

mouse-click. (Any user-defined PDF can be 

substituted for the default BSL Lesson PDFs.) 

▪ Edit onscreen HTML Journal content to create custom onscreen instructions with the built-in BSL 

Visual editor. 

▪ Configure Instructor (Host) and Student (Client) network settings for sharing lesson content. You 

don’t need to be an I.T. expert! Simply select the Host and Client computers in the BSL PRO 

Preferences to connect automatically over your local network. 

▪ Share PRO Lessons and Shared Lessons over your network.  

o BSL PRO Lessons  - H01-H36 and A02-A17 

o Shared Lessons are custom lessons created by the instructor. 

 

For more information on the BSL Curriculum Management System licensed feature, see Chapter 18 of 

your BSL PRO Manual or contact BIOPAC.
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MP36/35 Data Acquisition Unit Technical Information 

The MP Data Acquisition Unit is the heart of the Biopac Student Lab System. The MP Unit has an 

internal microprocessor to control data acquisition and communication with the computer. The MP Unit 

takes incoming signals and converts them into digital signals that can be processed with your computer. 

There are four analog input channels, one of which can be used as a trigger input. You will need to 

connect the MP Unit to your computer and connect electrodes, transducers, and I/O devices to the MP 

Unit. You are encouraged to take a few minutes to familiarize yourself with the MP Unit prior to making 

any connections. 

The MP36/35 Data Acquisition Unit is a physiological data recorder designed for medical educational 

purposes. This system is used in medical education and research facilities. This system is not used for the 

mitigation, cure or diagnosis of disease. This device is NOT used in the home. Subject to IEC60601-1, the 

MP36/35 Data Acquisition System is CLASS II, type BF equipment. 

Symbols — MP36, MP35, and MP46/45  

Symbol Description Explanation 

 

Type BF 
Equipment 

Classification 

 

Attention Consult accompanying documents 

 

On (partial) 

Turns MP35 on assuming AC300A 

power adapter is powered by the 

mains 

 

Off (partial) 

Turns MP35 off if but AC300A 

power adapter remains powered by 

the mains 

 Direct current Direct current input 

 
USB USB port 

 

Functional Earth 

Ground 

Functional Earth Ground 

Connection 

 

Class II Equipment 
Class II Medical Equipment, as 

established by IEC60601-1 

 
Fuse Equipment Fuse 
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Compliance 

  Safety 

The MP36/35 satisfies the Medical Safety Test Standards affiliated with IEC60601-1. The MP36/35 is 

designated as Class I Type BF medical equipment 

  EMC 

The MP36/35 satisfies the Medical Electromagnetic Compatibility (EMC) Test Standards affiliated 

with IEC60601-1-2. 

Types of Input Devices 

There are three types of devices that connect to the MP UNIT: electrodes, transducers, and I/O devices. 

Electrodes are relatively simple instruments that attach to the surface of the skin and pick up electrical 

signals in the body. 

Transducers, on the other hand, convert a physical signal into a proportional electrical signal. 

Input/Output devices (I/O for short) are specialized devices like pushbutton switches and headphones. 

Simple Sensor Connectors 

Regardless of the type of device connected, every sensor or I/O device connects to the MP UNIT using a 

“Simple Sensor” connector. Simple Sensor connectors are designed to plugs only one way into the MP 

UNIT, so you don’t have to worry about plugging things in upside down or into the wrong socket. 

Electrodes, transducers, and the pushbutton switch all connect to the channel input ports on the front 

panel of the MP UNIT. 

Headphones and the stimulator connect to the “Analog out” port on the back panel of the MP UNIT. 

MP36/35 only: A digital device may connect to the “I/O Port” on the back panel  

MP36/35 only: A trigger device may be connected to the “Trigger” port on the back panel. 

Front Panel 

 
Front Panel, MP UNIT 

The front panel of the MP UNIT has an electrode check port, four analog input ports, and two status 

indicators. 

Electrode Check 

 The Electrode Check port is a diagnostic tool used with the BSL PRO software to determine if the 

electrodes are properly attached to the subject. 

Input ports: CH 1, CH 2, CH 3, and CH 4  

The inputs on the MP UNIT acquisition unit are referred to as Channels. There are four 9-pin female 

analog input ports on the front of the MP UNIT. The Biopac Student Lab Lessons software will always 

check to see that you have the proper sensors connected to the appropriate channel. 
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Status indicators 

The Busy status indicator is activated when the MP UNIT is acquiring data and also during the first few 

seconds after the MP UNIT is powered on to indicate that a self-test is in progress. (When the MP UNIT 

passes the power-on test, the Busy light will turn off.) 

The Power status indicator is illuminated when the MP UNIT is turned on. 

Back Panel 

 

Back Panel, MP36/35 

The back panel of the MP36/35 has an analog output port, a USB port, an I/O Port, a Trigger Port, a DC 

input, a fuse holder, and a power switch, and the unit’s serial number. 

Analog Out port 

There is one 9-pin male “D” analog output port on the back of the MP UNIT that allows signals to be 

amplified and sent out to devices such as headphones. 

USB port (MP36/35 only) 

The MP36/35 connects to the computer via a USB Port, located just below the word USB. 

• Uses a standard USB connector. 

• Should only be used to connect the MP36/35 to a PC or Mac. 

Headphone Output (MP36/35 only) 

• Accepts a standard (1/4” or 6.3 mm) stereo headphone jack. 

I/O Port (MP36/35 only) 

• Accepts a DB 25 Female connector. 

• Input/Output port used to connect digital devices to the MP36/35. 

Trigger Input (MP36/35 only) 

• Accepts a male BNC connector. 

• Input port used to send trigger signals from another device to the MP36/35. 

• Used to synchronize MP36/35 units when more than one MP36/35 is used. 

DC Input 

Use the DC Input to connect an AC300A power adapter or BAT100 battery to the MP36/35. 

 The power supply requirements for the MP UNIT are 12 VDC @ 1 Amp. Only use the AC300A 

power adapter with the MP36/35. The AC300A is a 12 VDC @ 1.25 Amp power supply adapter that can 

connect to any mains rated as 100-250 VAC @ 50/60 Hz, 40VA. 

The receptacle is configured to accept a “+” (positive) input in the center of the connector and a “-” 

(negative) input on the connector housing. 
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 The functional earth ground on the AC300A Power Adapter is tied to Mains earth ground and 

accessible metal parts on the MP36/35 unit. 

  The AC300A power adapter is Class II and when it is used to power the MP36/35, the MP36/35-

AC300A combination is Class II. The MP36/35 unit also incorporates an additional level of isolation 

between the AC300A power adapter and the Subject. 

Fuse holder 

 The fuse holder contains a fast-blow fuse that helps protect the MP UNIT from shorts on its 

power, analog, and digital I/O lines. The MP36/35 uses a 1.0 A, 250 V, 3AG, fast-blow fuse and the 

MP30 uses a 2.0 A, 250 V, 3AG, fast-blow fuse. 

To remove the fuse, use a screwdriver to remove the fuse cover located below the word Fuse. 

Power switch 

ON position — powers up the MP UNIT 

OFF position — cuts the flow of power to the MP UNIT 

Mains Power Disconnection 

To completely disconnect the MP36/35 unit and the AC300A power adapter from all poles of the supply 

mains, extract the power cord plug from the mains outlet. Extract the plug by grasping the plastic shell of 

the plug and pull firmly away from the mains outlet in a direction perpendicular to the face of the mains 

outlet. Take care not to touch the metal blades associated with the plug. This procedure will fully power 

down (de-energize) the MP36/35 unit and AC300A power adapter. Please note that the power switch on 

the back of the MP36/35 unit turns power ON and OFF to the MP36/35 unit only. 

Cleaning Procedures 

Be sure to unplug the power supply from the MP UNIT before cleaning. To clean the MP UNIT, use a 

damp, soft cloth. Abrasive cleaners are not recommended as they might damage the housing. Do not 

immerse the MP UNIT or any of its components in water (or any other fluid) or expose to extreme 

temperatures as this can damage the unit. 

Sterilization and Disinfection 

Disposable, sterile, single-use-only, accessories are used with the MP UNIT for educational (teaching) 

applications. Non-disposable accessories can be disinfected, if required, with Cidex® or equivalent. 
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MP36/35 Input > Output Scaling 

The MP36/35 hardware can pipe signals from any channel input to the output using the “CHX to Output” 

control panel in the BSL PRO software—due to the difference between the input and output range, there 

will be a change in signal level (scaling). The output range depends on the MP device and the output pin 

used as shown in the following table. Note that when using MP35 output pin 2, there is an additional 

baseline offset (2.048 V) applied. 

Output Pin 

(Analog Out port) 

Pin Description Output Range 

(Volts)  

Pin 1* - MP36/35 
Headphones,  

A.C. Coupled 

-2.048 to +2.048 

Pin 2 - MP36 

 

 - MP35 

Low Voltage Stimulator, 

D.C. Coupled 

-10 to +10  

CH Data, 

D.C. coupled 

0 to +4.095 V 

(baseline offset of 2.048 V) 

The input range is gain dependent. The table below shows the scaling (multiplying) factors to use for each 

gain setting. 

Gain Input Range 

+- millivolts 

Output Scale***—accurate to ±10% 

Factor 1 Factor 2 

Pin 1 (Headphone out) 

and Pin 2 (MP35 only) 

Pin 2 (Low Voltage 

Stimulator) – MP36 

only 

x5** ± 2 V 1.024 5 

x10 ± 1 V 2.048 10 

x20 ± 500 mV 4.095 20 

x50 ± 200 mV 10.238 50 

x100 ± 100 mV 20.475 100 

x200 ± 50 mV 40.950 200 

x500 ± 20 mV 102.375 500 

x1,000 ± 10 mV 204.750 1,000 

x2,000 ± 5 mV 409.500 2,000 

x5,000 ± 2 mV 1023.750 5,000 

x10.000 ± 1 mV 2047.500 10,000 

x20,000 ± 0.5 mV 4095.000 20,000 

x50,000 ± 0.2 mV 10238.000 50,000 

Notes 

* 1: To properly measure the output signal you need at least a 2K Ohm load. 

**  2: x5 only available on MP36 and MP46/45. 

*** 3. Input to Output scaling is accurate to within 10%. 

Example: 

MP35, input signal level = ±10 mV (20 mV- pk to pk), input gain = x100, Output on pin 2. 

Signal output level = 20 mV-pk to pk x 20.475 = 0.4095 V pk to pk. 

However there is a baseline offset of 2.048 V, so actual signal output level is:  

Lowest level = 2.048 V – (0.5 x 0.4095 V) = 1.843 V  

Highest level = 2.048 V + (0.5 x 0.4095 V) = 2.253 V 
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Index to Instructor’s Guide 

A 

About Biopac Student Lab · 40 
Access to Lesson Procedures · 32 
Analyze a data file · 37 

B 

BEEP sound for lessons · 36 
Biopac Student Lab PRO · 67 
BSL launch error · 12 
BSL PRO features in RSD analysis mode · 

26 

C 

Calibration · 36 
CE Marking · 71 
Channel Box Region · 58 
Channels, show/hide · 46 
CISPR Class 11 · 72 
Closing the application · 39 
Compliance · 71 
Copy graph, Data Window · 59 
Copy measurement, Data Window · 59 
Copy to Floppy or Network · 62 
Copy wave data, Data Window · 59 
Customizing lessons · 67 
Customizing menu display · 26 

D 

Data Analysis · 41 
Data Report · 41 
Data Window · 13, 16 
Data Window, Edit menu option · 59 
Display entire data file · 51 
Display Menu · 51 
Display windows · 13 

E 

ECG Filter preference · 19 
Event  Palette · 52 
Event Markers · 52 

Experimental Methods · 34 
Experimental Objectives · 33 

F 

File>Preferences display · 26 
Functionality — mode differences · 16 

G 

Grids 
preference · 20 

Grids · 16 
Grids · 46 

H 

Hardware Connections · 10 
Headphone Volume preference · 20 
Horizontal axis · 68 

I 

IEC60601 · 71, 72 
Input/output (I/O) Devices · 10 
Instructor Editable Variables · 26 
Introduction · 33 

J 

Journal · 13, 16, 39 
Format Journal entries · 59 

Paste wave data · 60 

Save the journal · 62 

Text entry · 61 

Time and Date stamps · 61 

Journal Text preference · 21 

L 

Launch error, BSL or BSL PRO · 12 
Lesson customization · 67 

M 

Markers · 16 
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Materials · 33 
Measurement tools · 56 
Measurement Tools · 47 
Measurement type · 57 
Medical equipment, classification · 72 
Menu display, customizing · 26 
MP35 

Back Panel · 73 

Front Panel · 72 

MP35 Specifications · 71 

O 

oscilloscope display mode · 54 
Overlap button · 54 

P 

Preferences · 17 
ECG Filter · 19 

Grids · 20 

Headphone Volume · 20 

Journal Text · 21 

Menu display · 26 

Residual Volume · 22 

Respiration Transducer · 22 

Resting Skin Temperature · 22 

Temperature Scale · 23 

Printing · 16, 48 
PRO features in RSD analysis mode · 26 
PRO software features · 67 

Q 

Quit · 37 

R 

Recording · 36 

Residual Volume preference · 22 
Respiration Transducer preference · 22 
Resting Skin Temperature preference · 22 

S 

Safety · 71 
Saving · 16, 48 
SC for Selected Channel · 57 
Scales, adjusting · 49 
Selected area 

Selecting a single point · 55 

Selecting an area · 55 

Selecting a file to review · 43 
Set Up · 34 
Sound (beep) for lessons · 36 
Split button · 54 
Startup customization · 26 
Startup Script, modifying · 26 
Symbols, MP35 unit · 71 

T 

Temperature Scale preference · 23 
Text entry, journal · 61 
Time and Date stamps, journal · 61 
Type in your file name · 35 

V 

Vertical axis · 68 
Viewing data · 14 

Z 

Zoom · 50 
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Copyright 

Information in this document is subject to change without notice and does not represent a commitment on 
the part of BIOPAC Systems, Inc. This manual and the software it describes are copyrighted with all rights 
reserved. Under copyright laws, this manual or the software may not be copied, in whole or part, without 
the written consent of BIOPAC Systems, Inc., except in the normal use of the software or to make a 
backup copy. 

The same proprietary and copyright notices must be affixed to any permitted copies as were affixed to the 
original. This exception does not allow copies to be made for others, whether or not sold, but all of the 
material purchased (with all backup copies) may be sold, given, or loaned to another person. Under the 
law, copying includes translating into another language or format. 

Biopac Student Lab Lessons, including all text and graphics, are © BIOPAC Systems, Inc., with all rights 

reserved. 

Limited Warranty 

BIOPAC Systems, Inc. guarantees its equipment against all defects in materials and workmanship to the 
original purchaser for a period of 12 months from the date of shipment unless otherwise stated below; 
effective 1-1-2015, BIOPAC MP36 units are guaranteed against defects in materials and workmanship to 
the original purchaser for a period of 60 months (5 years) from the date of shipment. 

If BIOPAC Systems, Inc. receives notice of such defects during the warranty period, BIOPAC Systems, 
Inc. will at its option, either repair or replace the hardware products that prove to be defective in materials 
or workmanship. This warranty applies only if your BIOPAC Systems, Inc. product fails to function 
properly under normal use and within the manufacturer’s specifications. This warranty does not apply if, in 
the sole opinion of BIOPAC Systems, Inc., your BIOPAC Systems, Inc. product has been damaged by 
alteration, accident, abuse, misuse, neglect, improper packing, shipping, modification or servicing, by any 
party other than BIOPAC Systems, Inc. If a problem arises, please contact us for authorization before 
returning an item. 

Any returns should be supported by a Return Mail Authorization (RMA) number issued by BIOPAC 
Systems, Inc. BIOPAC Systems, Inc. reserves the right to refuse to accept delivery of any shipment 
containing any shipping carton which does not have the RMA number(s) displayed on the outside. The 
Buyer will prepay transportation charges to the BIOPAC Systems, Inc. designated site. The warranty 
period for repairs and for used equipment purchased from BIOPAC is 90 days. 

BIOPAC Systems, Inc. makes no other warranty or representation, either expressed or implied, with 
respect to any hardware or software product, its quality, performance, merchantability, or fitness for a 
particular purpose.  

BIOPAC Systems, Inc. will not be liable for direct, indirect, special, incidental, or consequential damages 
resulting from any defect in a hardware or software product or its documentation, even if advised of the 
possibility of such damages, or for damage of any equipment connected to a BIOPAC Systems, Inc. 
product. 

Trademarks 

BIOPAC® is a registered trademark of BIOPAC Systems, Inc. 

Windows® is a trademark of Microsoft Corporation. 
Mac® is a trademark of Apple. 

This document was created with Microsoft Word for Windows, Adobe PhotoShop, and Corel Draw 7.0. 
Mainstay Capture, FastStone Capture and JASC, Inc. JasCapture. 
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